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VERSION

Preface

This manual corresponds to Oracle Insurance Insight (OII) 7.0.2.

PURPOSE & AUDIENCE

The OII Implementation Guide is written for both a non-technical and a technical
audience. The chapters are grouped into three content categories or sections:

Section | - Strategic Goals (Big Picture Ideas)
e Chapter 1 - Introduction

*  Presents the business objectives that OIl was designed to address.

Section Il - Project Planning (Managing Timelines)
* Audience — Project managers
¢ Chapter 2 - Implementation Lifecycle

* A standardized approach to implementing the OII system from scratch.

Section Il - Implementation (Technical Details)
* Audience — Implementation team
e  Chapter 3 - Program Flow
* Familiarizes the user with the OII data architecture.
* Chapter 4 - Source-to-Staging ETL

*  Outlines the key goals and best practices for building an Extraction-
Translation-Loading (ETL) layer that feeds OII.

* Chapter S - Data Loading

* A step-by-step guide to loading data from Staging to Warehouse to Data
Marts.

*  Chapter 6 - Data Visualization

* A step-by-step guide to updating and linking the Oracle Business
Intelligence Enterprise Edition (OBIEE) Repository.
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e Chapter7 - Balancing Reports

» Balancing Reports are a set of reports that can be opened and edited in BI Publisher
to verify data flow between schemas in OII. This chapter describes how to deploy
and manage these reports for use in Bl Publisher.

For the purpose of the guide, it is assumed that all components have been installed and all
environments have been setup. This guide walks the user through the planning and execution
of an OII implementation.

For better understanding, the Implementation chapters assume knowledge of:
* Database management systems (DBMS), specifically Oracle 11g,

*  Programming Language Structured Query Language (PL/SQL) and

e Oracle Data Integrator (ODI) 11g

LIST OF ACRONYMS AND ABBREVIATIONS

To make using this guide easier, all the full name is used the first time an acronym appears.
In addition, all acronyms used in the OII Implementation Guide are listed below:

*  CSI - Customer Support Identifier

*  DBMS - Database Management System

* ETL - Extraction, Translation and Loading

* LOB - Line of Business

* OBIEE — Oracle Business Intelligence Enterprise Edition
*  ODI - Oracle Data Integrator

* OIL DM - OII Data Mart schema

e OIL ST - OII Staging schema

* OIL WH - OII Warehouse schema

*  OII - Oracle Insurance Insight

* OII Core — OII Core Data Model

e OLTP — Online Transaction Processing

* PL/SQL — Programming Language/Structured Query Language
*  SCD - Slowly-Changing Dimension

* UAT — User-Acceptance Testing

* UDF — User-Defined Field
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NAMING CONVENTIONS

To make using this guide easier, database objects are capitalized and italicized throughout
the OII Implementation Guide:

Example: Ol ST.PLCY TRANS (Policy Transaction)
*  OIl ST - The relational (i.e. database) schema name
e PLCY TRANS - The relational (i.e. database) table name

*  Policy Transaction — The logical table name

RELATED DOCUMENTS

For more information, refer to the following documents:

Oracle Insurance Insight Release Notes - This document describes the latest
enhancements and updates to OII as well as issues that have been resolved in this version.

Oracle Insurance Insight Installation Guide - This manual describes the steps for
configuring and installing OII.

Oracle Insurance Insight Administration Guide - This manual describes how to create
and configure the required OII users and groups within OBIEE.

Oracle Insurance Insight Warehouse Palette User Guide - This manual describes how to
use the Warehouse Palette, an application that provides users with an easy-to-use
interface to create and configure a Line of Business (LOB) and “publish” the LOB for
incorporation into the OII system.

Oracle Insurance Insight User Guide - Oll uses OBIEE 11g as its front end interface,
providing a set of dashboards, reports, and query building tools to use to analyze the OII
data. This manual describes how to configure and run the OII reports as well as use the
OBIEE analytic features to build custom queries to run against the OII data.

Oracle Insurance Insight Data Dictionary - The data dictionary for the OII system.

Vii
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CUSTOMER SUPPORT

If you need assistance with OII, you can log a Service Request at My Oracle Support
(https://support.oracle.com). You will need your Customer Service Identifier (CSI) to
register.

For community support, you can login to Oracle Mix (http://mix.oracle.com) and join the
Insurance Business Intelligence and Data Warehousing group
(https://mix.oracle.com/groups/18191) to review posts and/or create your own post to
request assistance.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

viii
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Chapter 1

Introduction

The Introduction answers high-level “What” questions. Subsequent sections go into more detail and
answer “How” questions. The Introduction serves two purposes:

* For an executive audience, this chapter answers the key questions about what OII can do and
what problems it solves. This audience may not need to read beyond the Introduction.

* For a technical audience, this section gives perspective on what is meant to be accomplished in
an OII implementation. It gives relevance to the technical details discussed throughout the rest of
the guide.

WHAT LINES OF BUSINESS ARE SUPPORTED?

Six pre-defined Lines of Business (LOBs) are included with OII out of the box:
*  Personal

e Dwelling Fire

*  Homeowners

*  Personal Auto

*  Personal Umbrella
*  Commercial

*  Commercial Auto

e Commercial Property

Additional LOBs can be created from scratch or by using one of the six pre-defined LOBs as a
starting template. Through the flexibility of the OIl Adaptive Data Mode, any LOB can be edited in
the Warehouse Palette. See the OII Warehouse Palette User’s Guide for further information.

WHAT IS INCLUDED IN THE CORE DATA MODEL?

Many details about claim and policy transactions are common across different carriers and LOBs.
The OII Core Data Model (OII Core) represents that part of the data architecture that is shared by all
LOBs. All metrics and universal claim and policy transaction details for all LOBs reside in the OII
Core and are exposed in the OII Corporate data marts:
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e Monthly Snapshot Marts
¢ Claim
*  Combined Policy & Claim
» Transactional Marts
¢ Claim
* Policy
Metrics are also presented with rich, LOB-specific dimensions in an additional data mart per each
implemented LOB:
*  LOB Combined Policy & Claim Monthly Snapshot

The four Corporate and one LOB-specific data marts listed above represent the default data marts
provided by OII out of the box. OII provides the underlying data elements (i.e. fact tables and
dimensions) for up to six data marts for Corporate data and for each implemented LOB. With
Corporate data and the six pre-configured LOBs supplied with OII, this would allow for a total of up
to forty-two data marts:

*  Monthly Snapshot Marts
*  Claim
*  Combined Policy & Claim
*  Policy

* Transactional Marts
e (Claim
*  Combined Policy & Claim
* Policy

WHAT ARE DIMENSIONS?

The concepts and calculations surrounding premiums, exposures, and losses are contained within the
OII Core. Loss Reserve calculations, for instance, remain the same regardless of LOB. The
dimensions, or risk items, are what differentiate one LOB from another. A dimension can be a
covered item such as a vehicle. A dimension can also be something that provides additional detail
about the policy such as a garage on a Personal Auto policy. Each of the supported LOBs is a
collection of dimensions that describe that LOB.

For example, the pre-defined dimensions for Personal Auto include Vehicle and Driver. Looking at
a metric across more than one dimension such as Paid Loss by Territory and Month is referred to as
multi-dimensional analysis. A practically infinite number dimensional views are available in OII.

Creating and viewing reports for OII in OBIEE is covered in-depth in the OII User Guide.
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What is the Adaptive Data Model?

WHAT IS THE ADAPTIVE DATA MODEL?

In the OII Adaptive Data Model, LOB dimensions are controlled directly by business users through
the Warehouse Palette. OII automates the technical creation and configuration of the warehouse
components (e.g. database tables, interfaces, internal ETL). Data model design is abstracted from the
underlying physical database. The IT department has complete flexibility to scale the application
appropriately, removing traditional modeling constraints.

The Warehouse Palette is a web-based application that allows users to create an LOB and configure
the dimensions and associated attributes that make up the LOB. Its purpose is to provide users with
an easy-to-use interface that facilitates building and modifying an LOB’s components without
directly managing the related technical details. Once the user “publishes” the LOB, the physical
database structures and loading mechanisms (i.e. the interfaces and the internal ETL) are
automatically added to OII.

IMPORTANT Once an LOB is published using the Warehouse Palette it is locked and cannot be
modified. A published LOB must be “unpublished” in order to make additional edits. The
process of unpublishing deletes all data for that LOB and removes any LOB-specific
structures from the database.

Instructions on how to extend the OII data model are contained in the OII Warehouse Palette User
Guide.

WHAT ARE SLOWLY-CHANGING DIMENSIONS?

Dimensions come from two sources, the OIl Core and Adaptive dimensions:
*  Core

* Dimensions and their attributes in the OII Core that relate to all LOBs (e.g. Class, Limit,
Producer)

* Adaptive

*  LOB-specific risk items contained in the metadata supplied for a pre-defined LOB (e.g.
Driver, Dwelling, Vehicle)

*  LOB-specific risk items (e.g. Watercraft) or other descriptive attributes (e.g. Boat Length or
Boat Type) built in the Warehouse Palette

With such variability among dimensions, OII offers two widely-used Slowly Changing Dimensions
(SCD) methodologies to manage changing dimensional data over time:

* Type 1SCD
*  Type 2 SCD

The Type 1 SCD methodology is a simple approach to dealing with dimensional attribute changes.
Only the current state of the dimension is preserved. The fact table is unchanged. When a dimensional
attribute changes, the previous value is overwritten with the current value.

Dimension bloat is minimized, and performance is optimized for a Type 1 SCD. The obvious
disadvantage to this method is that no record of historical attribute values is kept.
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A Type 1 SCD is a good choice if there is little or no analytical benefit in maintaining old attribute
values. Type 1 may also be a good choice if the dimensional attributes are expected to change
frequently and there is little value in maintaining history.

The Type 2 SCD methodology is the primary technique for tracking historical data. Given a Natural
Key supplied in the OII Staging schema, Type 2 SCDs generate a new dimensional record whenever
anew attribute value is loaded. These new records, identified by a surrogate key, are linked to the fact
table. With each new dimensional record added, the fact table is automatically partitioned in time and
permanently bound to the dimensional attributes that define that time slice.

Type 2 SCDs preserve unlimited history, allowing for powerful data analysis. As a consequence,
storage of unlimited history and query performance across an expansive table may affect
performance.

A Type 2 SCD is a good choice if historical analysis offers analytical value and the dimension truly
is slowly-changing. Type 2 may not be

a good choice if the attribute in question is subject to frequent change.

Each individual dimension can be set as a Type 1 or Type 2 SCD in the Warehouse Palette. This
setting affects how changing dimensional data is handled in the Data Mart schema. In the Warehouse
schema, full transactional history is always preserved for detailed analysis.

IMPORTANT! A Natural Key must be supplied for ALL rows in a dimension table if Type 1 or Type 2 is
selected in the Warehouse Palette. History cannot be maintained in OIl without the
presence of a Natural Key in every row of the dimension table.

IMPORTANT For the source data in the Staging schema, for a given Natural Key, each row should
have a different Transaction Effective Date (i.e. the Transaction Effective Date should
be at least different in seconds).

Otherwise, If duplicate Transaction Effective Dates are present, the row with the highest
ROW_NUM sharing the same Natural Key and same Transaction Effective Date will be
considered as the latest and only business attributes from this row to be recorded into
the Warehouse. This would result in losing the attributes changing history.

WHAT ARE METRICS?

Metrics are quantifiable measures that represent a piece of business data as seen in relation to one or
more dimensions. An example would be Earned Premium by Month. In this case, Earned Premium
is the metric and the dimension would be time (i.e. Month). All metrics are contained in the OII Core.
There are too many metrics in OII to name them all here. Examples of other metrics include:

¢ Claim Count

*  Future Written Premium
e In Force Premium

e Incurred Loss

* Loss Reserve

See the OII User Guide for a complete list of metrics.




What Is ODI (Data Loading)?

Earned Premium deserves a special note because OII can calculate it in a number of ways. If raw
premiums are included for policy transactions, OlI can calculate Earned Premium using one of these
methods:

*  Monthly (1/24th)

e Daily

* Seasonal (utilizes a pre-defined table with seasonal factors)
*  Original Premium

Alternatively OII can also accept pre-calculated Earned Premium amounts and forgo internal
calculations. Earned Exposure is also treated in this manner.

WHAT Is ODI (DATA LOADING)?

ODI is an ETL tool that is used to load the OII data model schemas from Staging to Warehouse and
Warehouse to Data Marts. Custom dimensions built in the Warehouse Palette are published to the
Oracle database and supplement the OII Core. In the publish process, ODI is updated to handle new
dimensions just as it would the OII Core components. Using ODI to load OII is covered in-depth in
Chapter 5: Data Loading.

WHAT Is OBIEE (DATA VISUALIZATION)?

OBIEE is a data analysis tool that sits on top of the OII data model, providing dashboards, reports
and custom analytic queries that help bring out novel characteristics inherent in the data. OBIEE use
and configuration is covered in-depth in the OII User Guide. In OBIEE, dimensions are known as
“filters” because of their ability to focus analysis on limited, relevant data.

See the OII User Guide for a complete listing of pre-defined filters, including those supplied with the
six pre-defined LOBs. Linking OBIEE to the OII data model is covered in-depth in Chapter 6: Data
Visualization.
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Chapter 2

Implementation Lifecycle

STANDARD OIll PROJECT STAGES

The standard OII implementation process is separated into four project stages as follows:
1. Initiation

2. Planning

3. Execution

4. Deployment

Initiation

In the Initiation stage, the customer’s current source system(s) and requirements are assessed. Based
on the estimated transactional data volume and allowing for growth hardware sizing can be assessed
to determine configurations needs.

Planning

In the Planning stage, the following occurs:

* A detailed data analysis is performed to determine which fields will be exposed within OII, where
they come from in the client’s source system(s) and establish valid values.

» Data Mapping is performed in order to map the source system(s) data to OII Staging tables. This
involves mapping of policy and claims data.

* Source codes are defined and standardized by the client in order to accommodate the OII data
model and to ensure data consistency over time.

» Entities, operation, distribution and other hierarchies are defined prior to Source-to-Staging ETL
development in order to enforce the correct parent-child relationships.

* The client’s Earned Premium, Earned Exposure (if implemented) and Incurred Loss calculation
methods are determined in order to configure OII for the selected pre-defined calculation
methods.

*  Signoff Metrics/Tolerances are established in order to commit to criteria for successful testing.

» Hardware is procured and configured. Required software is installed.

11
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Execution

In the Execution stage the following occurs:

The Source-to-Staging ETL is also designed and developed.
Testing/balancing is done from the source system(s) data to the Staging tables.

The Source-to-Staging ETL is re-tooled, as necessary. No calculations are performed on the
Staging tables, so balancing from the source to the Staging tables is an iterative process of
loading, testing and re-tooling the Source-to-Staging ETL.

Warehouse and Data Mart loads are run followed by balancing.

Routine data loads are configured in ODI. The loads must be configured to ensure there are no
data gaps or duplications and that the process can integrate with the source system, month-end
processing cycles, etc.

User Acceptance Testing (UAT) is performed. After the OI’s numbers match the agreed
tolerances, Ol is presented to the end users.

Based on end-user feedback and request from the end users the OII/OBIEE data views can be
customized.

Deployment

In the Deployment stage migration to production, administrative training, end-user training and
transition to support takes place.

STANDARD OIl IMPLEMENTATION PROCESS

The timelines below are estimates for a standard OIl implementation of a single LOB (e.g.
Commercial Auto or Homeowners) that includes policies and claims from a single source system.
The time ranges could increase or decrease based upon the number of LOBs, the number of source
systems and the complexity of data extraction from the source system. Coordinating multiple source
systems and multiple LOBs in an OII environment often requires coordinated data mapping and ETL
design so that a consistent view can be presented across all LOBs.

DATA MAPPING

Scope: During this phase, the required and desired fields to be exposed within OII and the
corresponding fields in the source system(s) are identified. Customizations needed for the
Adaptive Data Model are identified. Sign-off metrics and tolerances are established during this
period. Allocation of server resources and storage space are arranged prior to the ETL
Development phase. Accommodations are also made to store the staging data.

Client Resources:

*  One or more BAs who are familiar with the data from an insurance and end-user perspective

e  One technical resource who is familiar with accessing data and data architecture at a high
level in the source system(s)
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Assumptions:

N/A

Risks:

Multiple source systems increase the complexity and required time for this phase.

SOURCE-TO-STAGING ETL DEVELOPMENT

Scope: During this phase, the OIl Warehouse Palette is used to customize the Adaptive Data
Model. From here, the Source-to-Staging ETL is designed, developed and re-tooled in order to
perform any necessary data cleansing before moving data into the Staging tables (a.k.a.
templates). Once transactions are loaded to the Staging schema, descriptions and translations
should be configured in OII. These descriptions and translations are applied to customer source
codes when OII loads from Staging to the Warehouse. To ensure that all expected transactions
were extracted from the source, loaded and processed by OII, balancing should be performed.

Client Resources:

One Business Analyst who can validate the relevance and appropriateness of the data being
extracted from the source system(s) and sign off on the data reconciliation metrics between
source and staging

One technical resource who is familiar with accessing data and data architecture at a high
level in the source system(s)

One technical resource who can code and test the Source-to-Staging ETL using SQL and/or
an ETL tool and execute the data load to Staging

Assumptions:

The Business Analyst resource should be readily available to answer questions concerning
the appropriateness of the data being extracted from the source system(s)

The two technical resources may be combined into one job role if a single resource has the
breadth of knowledge of the data architecture and the skill set to code the Source-to-Staging
ETL

Risks:

Poor data quality will require that more time be spent cleaning the data. Ideally, data
cleansing will be done in the source system(s) so that the source is consistent with what is
loaded into OII and so that data manipulation is reduced in the Source-to-Staging ETL.

Multiple source systems increase the time needed to develop separate loading mechanisms
and convert different code values from various systems into one consistent representation of
the data

If the required transactional fields were not properly identified and addressed in the Source-
to-Staging ETL, then it will take additional time to re-tool the Source-to-Staging ETL or
investigate ways to accommodate the missing data in OII
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DATA MART LOAD

Scope: The transactional and monthly snapshot Data Marts are loaded, and the OBIEE
Repository is customized to accommodate changes per the Adaptive Data Model.

Client Resources:

One BA who can communicate with the end users and sign off on the data reconciliation
metrics between the Warehouse and Data Mart schemas.

One technical resource who is familiar with accessing data and data architecture at a high
level in the source system(s)

One technical resource who can re-tool the Source-to-Staging ETL using SQL and/or an ETL
tool and execute the data load beyond the warehouse.

Assumptions:

OlIl reconciles to data in the templates and not necessarily to historical customer reports.

Risks:

Validation of Data Mart metrics (i.e. Earned Premium, Incurred Loss etc.) often involves a
process of discovery where missing data is identified, the Source-to-Staging ETL code is
updated and data is reloaded in OII (Staging, Warehouse and Data Marts). Focus on data
reconciliation at the Warehouse level will identify issues earlier when it takes less time to
reload. Waiting until the Data Mart Load to perform detailed data analysis may lead to
additional iterations of this phase.

There can be confusion around calculated Data Mart metrics because customer reports may
represent a different view of the same data. Both views may be correct and true
representations. The measure of success for OII is being able to reconcile the Data Mart
metrics to the Warehouse and Staging tables not necessarily to a customer report. Any
differences that cannot be reconciled may ultimately be due to incomplete Staging data (via
the Source-to-Staging ETL).

CusTomize OIll DATA VIEWS

Scope: In this phase, user requests are translated into custom OBIEE reports and data views.

Client Resources:

End-user feedback (dashboard/report requests) and availability for training
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Chapter 3

Program Flow

The focus of this chapter is an overview of the flow of data between the processing stages in OIL.

Each of the six pre-defined LOBs provided with OII represent a reference implementation that is
adaptable and customizable. An understanding of program flow is required to properly plan and
implement an OII solution..

Note Keep in mind that the content presented herein is representative of the reference
implementation of Oll. The reference implementation is a model upon which an actual
implementation is based. As such, actual implementation details may differ from the
model.

The OII program flow utilizes three different schemas for processing: Staging, Warehouse and Data
Mart. Generally speaking, data is slightly denormalized in the Staging schema. Depending on the
source system data structures, the loading process may or may not include additional
denormalization. During the flow of data from Staging into Warehouse, some renormalization
occurs. Finally, during the flow of data from Warehouse into Data Mart, data undergoes
denormalization. The purpose of the de- and renormalization is to reduce redundancies, flatten
hierarchies, and prepare for the final load into fact and dimension tables in the Data Mart.

STAGING SCHEMA CONCEPTS

The Staging schema introduces several components that are important to understand:
*  Party Model

* Contact

»  Postal Address

*  Natural Keys

*  Row Number

*  Relationship Model

*  Normalization and Denormalization

»  User-Defined Fields

*  Concepts in Practice

These concepts are used to allow for flexibility and reuse in the system while maintaining a high level
of performance in the Data Mart schema.
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PARTY MODEL

The Party Model is used to establish roles and relationships for entities referenced in transactional
data. The OIl ST.Party (Party) table is at the top of the Party Model hierarchy and contains fields
shared by all Party Types. In this context, Party Type can refer to a person or an organization, while
a Party Role describes the entity with respect to the transaction. This concept is illustrated in the
following example:

John Smith is a personal auto policy holder for Alamere Insurance Company. For data
relating to his personal auto policy, John is a PERSON party type, and holds the party role
of INSD (INSURED) for the Personal Auto LOB. Similarly, Alamere Insurance Company is
an ORG party type, and holds the role of INSUR_CO (INSURANCE COMPANY) in this
LOB with respect to this transaction.

The Party Model allows for an entity to hold more than one role or relationship within the system
and allows for the relationship to be established across LOB boundaries. This results in reduced data
volume and enhanced reporting capabilities. This concept is illustrated by expanding on the
previous example:

John Smith calls his agent and, during usual customer service interaction, learns that
Alamere Insurance Company also offers Homeowners insurance policies. John requests a
quote. In OII, John is already established as a PERSON party type. In the Homeowners
LOB, he now holds the role of PROSPECT. His PERSON data is common to both LOBs.

Finally, the Party Model introduces context and hierarchies for entities and roles within the system.
The Party-Level Relationship Code of the party establishes an entity’s relationship to the transaction
or to other parties. See the concept illustrated below, built upon the previous examples:

John Smith’s insurance agency is established as an ORG party type. Similarly, the agent is
a PERSON entity. With respect to transactions involving John’s policy, the agency holds the
PRODR (PRODUCER) party role while the agent holds the SUB_PRODR
(SUBPRODUCER) party role. The hierarchy of PRODUCER and SUBPRODUCER is
expressed via the Role-Level Relationship Code in the Party Model.

The actual relationship code values used in Oll at the Party, Type and Role level match the
database table name for that entity. When a new party dimension is created in Warehouse
Palette, the table name becomes the new relationship code representing that entity. The pre-
defined Oll relationship codes are listed in Appendix A: Chapter A: Relationship Codes.

CONTACT

The OII ST.CNTCT (Contact) table provides flexibility for defining contact endpoints for physical
entities such as people or office locations. Currently, the Contact table extends only a physical
address as a contact endpoint, or entity type. This information is housed in the OIl ST.PSTL _ADDR
(Postal Address) table. In the future, additional entity types can be added, such as phone numbers
and email addresses. A row in the Contact table is associated with a row in the Party table. A row in
the Party table can be associated with one or more rows in the Contact table. A row in the Contact
table is also associated with a row in the Postal Address table where the location information is
stored.
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John Smith is a Personal Auto policy holder with Alamere Insurance Company. He pays a

monthly premium for his policy. When his monthly payment transactions are loaded to the

Oll system, John'’s home address is listed as a row in the Postal Address table. This row is

then referenced by a row in the Contact table. The row in the Contact table is then referenced
in the Party table, which contains a reference to John’s entry in the Person table.

Note Since Contact is related to Party, it is important to note that if there are no rows in the
Party table, there will be no rows in the Contact table.

PoOSTAL ADDRESS

The Postal Address table is used to store address locations. During the migration process to the
Warehouse schema, the geographic boundaries present in the address are moved into a separate
Oll WH.GEOG_BNDRY (Geographic Boundary) table. A reference is created between the Postal
Address and Geographic Boundary tables. There are multiple types of geographic boundaries:

*  State or Province
* Region
*  Country

Regionalization of data by geographic boundary provides the OII user with a sufficiently granular
level of detail while not burdening the dimensions in the Data Mart schema with street information
(i.e. Address 1 and Address 2 fields) that is typically more useful in an operational environment (e.g.
the generation of mailing labels). Once data for Address 1 and Address 2 are migrated to the
Warehouse, it undergoes a regionalization transformation. All data is preserved at the Warehouse
level, while only the geographic boundary information is moved to the dimensions in the Data Mart
schema.

Note The basic installation for Oll is a model, so if requirements dictate a need to maintain
street address information in the Data Mart schema, the implementation team can
readily accommodate this request easily.

The Postal Address table is used by the Contact table when storing address information related to the
Party table. In addition, the Postal Address table is also used to store address information related to
vehicles and claims.

NATURAL KEYS

Natural Keys are unique data identifiers of specific elements within the Staging schema. Natural
Keys are typically associated with several types of data elements including Entities, Parties, Claims
and Policies. A Natural Key serves multiple purposes, one of which is the ability to associate rows in
one table with one or more rows in one or more other tables. Natural Keys are one method to keep
data loads reduced which increase the performance of a data warehouse system by eliminating data
duplication. Additionally, Natural Keys are a good method to use for ensuring the correlation
between one or more tables for reporting purposes.
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For example, a Natural Key is used in conjunction with the Party Model to allow association of a
single entity with more than one role. Without the Party Model and Natural Keys, data duplication
would occur — over time, this duplication results in reduced system performance and increased
overhead. The Natural Key ensures that the correlation between an entity and multiple roles is valid.
It is important in reporting to identify when roles are held by the same person or organization.

During the loading process, if a Natural Key is not supplied by the source system, a Natural Key is
generated as a checksum of the identifying columns — that is, the collection of columns that uniquely
identify a row — and is assigned to each transaction that is loaded from the customer data. If one or
more rows of incoming data have the same values in the identifying columns, the generated
checksum, the Natural Key, will be the same. Thus, it is important to ensure that the identifying
columns are indeed serving the purpose to identify unique rows. The alternative is for the customer
to supply a Natural Key.

The use of Natural Keys in OII has several caveats that are important to note for implementation
teams:

*  Every column with the exception of Natural Keys in the Staging model tables and Natural Keys
used for counts in the monthly snapshot tables within the marts must be populated with data —
that is, not NULL. Special notes on NULL values — with respect to fields with data type of string,
a single character, default a single space is used to represent a lack of data for a column that does
not allow NULLs. This single character can be configured in the Ol SYS CONFIG table.

*  Customers can supply their own Natural Keys from source systems provided the unique string
requirement is met.

*  Supplying Natural Keys must be performed in an all-or-nothing approach per entity; either all
rows within the entity will have a supplied Natural Key or none of them will.

e If Natural Keys are empty, OII will compute Natural Keys in the Staging-to-Warehouse data
population routines.

« If Natural Keys are computed, there must be enough sufficient non-empty data to establish a
unique distinction between data rows. Otherwise, logical errors will occur.

If Natural Keys are computed, Slowly Changing Dimension (SCD) support is not available — it is
impossible to implement Type 1 or Type 2 SCD. An SCD is a dimension that, as the name implies,
may change over long periods of time. If a Natural Key is not supplied, then it is computed based on
a collection of fields that uniquely identify a row in a table. Since it is then possible for one or more
fields in the collection to change, the computed Natural Key would then be different when data
changes. As such, there is no method to allow correlation of the changed data to its original state.

These concepts are illustrated in the following example:

Alamere Insurance Company designs a data structure that defines “person” entities. The
PERSON table that houses data rows for these entities consists of only two columns,
FirstName and LastName. Alamere decides to use First Name and Last Name rather than
tax identification numbers as keys to identifying entities in the person table for legal
reasons. Alamere is not currently computing natural keys. During data load to Oll, the
natural key is computed for each entity (row) in the table. If the “person” table contains
John Smith and Jane Smith, the computed natural key will suffice to uniquely identify the
two individuals. However, if a separate John Smith is entered in the “person” table, a
conflict will result in computing natural keys — there are not enough columns to uniquely
identify each row.
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Alamere has a “location” table which gives a physical location to a row in the “person”
table. If Jane Smith changes her last name to Jones, which results in an update to the
“person” table, the ability to correlate the location data will be gone — the computed
natural key for Jane Jones will be different from the computed natural key for Jane Smith.
The solution then is to either add more columns to the “person’ table which guarantee

uniqueness, or to have the source system generate a natural key that is added to each row
prior to import into OIIL

IMPORTANT For the source data in the Staging schema, for a given Natural Key, each row should
have a different Transaction Effective Date (i.e. the Transaction Effective Date should
be at least different in seconds).

Otherwise, If duplicate Transaction Effective Dates are present, the row with the highest
ROW_NUM sharing the same Natural Key and same Transaction Effective Date will be
considered as the latest and only business attributes from this row to be recorded into
the Warehouse. This would result in losing the attributes changing history.

Row NUMBER

In a typical relational database schema, a primary key is used to uniquely identify a row of data in a
table. Such keys are then used to provide references between different tables.For example, a primary
key in an Insured table would be referenced as a foreign key in a Policy table, indicating a relationship
between data in the Policy and Insured tables where the foreign key matches the primary key.
Because the database schema is particular to the company and in many cases the business units
therein, there is the potential to have as many different table definitions as there are business units
and companies.

To simplify creation and maintenance of ODI Interfaces which populate the Staging model from
customer data, the interfaces have been programmed to modify imported data by removing primary
and foreign keys which results in destruction of referential integrity.

However, there still exists a need to be able to generate a holistic view of a transaction across the
various tables in the model, and as such the data in Staging has introduced a unique identifier column:
row number (ROW_NUM). The row number is always present for every staging load, regardless of
how natural keys are provided or generated. The row number is simply a unique number, very similar
to an identity column in SQL Server, that increments per row (or rows, when relationship codes are
needed for uniqueness) within a given staging load to uniquely identify a transaction.

The ROW_NUM is used in each table in the Staging environment for all rows applicable to that
unique business transaction. As such, a virtual transaction can be built from the tables in the Staging
model using only the ROW_NUM.

RELATIONSHIP MODEL

In OII the relationship model is used to provide context and hierarchy in which multiple rows in a
given table can be related. Relationship codes are maintained in the O SYS schema.The relationship
code is expressed in tables within the Staging schema using a column named like object RLAT CD,
where object is the type of entity contained in the table. This column is used to provide a part of the
primary key of the table in addition to context and hierarchy. An example is shown below:
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The OIl ST.PRODR table contains Producer entities, and features the PRODR_RLAT CD
column. In practical applications, a Producer may have Sub-producer that is related. The
Sub-producer would also have a row entry in the PRODR table, and the relationship between
the two rows for the Producer and Sub-producer is represented in the values contained in the
PRODR RLAT CD.

The relationship model works in conjunction with the entities in the Party model to establish context
between parties and transactions, and establish relationships between parties with respect to
transactions.

NORMALIZATION AND DENORMALIZATION

Relational Databases used in online transaction processing (OLTP) are generally designed in a

systematic way that ensures the data structures are useful for querying and possess performance
characteristics that support OLTP. OLTP databases are characterized by a high volume of small
transactions, such as payment processing for policies.

Normalization describes the design pattern in which the data structures meet the needs used by OLTP
databases. For the purposes of OII, the main normalization characteristics that are import to
understand are table relationships built by keys, and the use of joined tables. Normalization attempts
to optimize database performance for inserting, updating or deleting records by storing different but
related data in separate tables.

By contrast, denormalization attempts to organize database structures in such a way as to provide
optimized performance for reading data. Databases used for online analytical processing (OLAP) are
usually designed with denormalized database structures. Since OLAP applications are used to
analyze trends in historical data over long periods of time, the sheer volume of accumulated data
requires either a high-performance database or a database structure that is built for fast reading. An
OII implementation provides both of these.

OlIl is an OLAP system, so the end-result of loading and program flow will result in denormalized
data in the data mart.

USER-DEFINED FIELDS

Since the data model provided by OII is a reference implementation, it is expected that the schemas
will be customized for each implementation. As such, most tables in the Staging and Warehouse
schemas feature five fields that can be used to house data not contained in other areas. These User-
Defined Fields (UDFs) allow for the data model to accommodate minor additions without having to
unpublish, edit and republish an LOB. The naming of these fields will always contain “UDF” in the
field name (e.g. PARTY _UDF_CD 1). The UDFs are normalized in Staging and Warehouse.
During the migration to Data Mart, the UDFs are denormalized in the dimension tables. As such, the
dimension tables in the Data Mart may contain up to 30 UDF columns to accommodate the 1-5 UDF
columns in each entity table. None of the UDF’s are included in the presentation layer. This means
that the end user will not see anything in the OBIEE user interface for those UDF’s that have been
utilized unless they are given a meaningful name, data is loaded to them and they are added to the
presentation layer in the OBIEE Repository to make them available to the end user. Chapter 6: Data
Visualization gives detailed instructions on how to enable custom dimensions, fields and UDFs in
OBIEE.
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CONCEPTS IN PRACTICE

The Party Model works in concert with Natural Keys to support the concept of multiple roles per
entity. In the Staging model, there are no Natural Keys established for roles (e.g. INSURED or
INSURANCE CO) or entities (e.g. PERSON or ORG). Instead, Natural Keys exist for each PARTY
row. The relationship between the ENTITY and ROLE is established by ROW_NUM, and the
hierarchy/context of the relationship is established by the relationship code (PARTY RLAT CD). In
this manner, the Natural Keys for PARTY need not be reloaded for each ROLE, since an ENTITY
may have more than one ROLE. The end result of the application of these concepts in OII:

* Less data is duplicated

* An ENTITY can hold more than one ROLE, and can be utilized across LOBs and subject areas
(Policy Transactions, Claims Transactions, Quote Transactions, etc.)

*  Business transactions can be presented holistically despite denormalization

The importance of Natural Keys for identifying rows cannot be understated — in order to ensure that
the initial data load and subsequent loads have consistency, the Natural Key process must be defined
accurately. This means that the customer must supply a Natural Key for each unique entity or must
identify the collection of uniquely-identifying rows. The Natural Key identifies an entity in the data
mart that is unique in its lifecycle. This concept is illustrated in the following example:

John Smith holds a Personal Auto policy with Alamere Insurance Company. Alamere chose
to generate Natural Keys during the load to the Staging environment. When John's policies
are loaded to the Warehouse, each Policy entity and related items (e.g. Vehicle entities,
Driver entities) are related by the Natural Keys associated with these items. This includes the
John Smith PERSON entity.

Subsequent to the historical load, Alamere issues a new Homeowner’s policy to John. During
the next load to the data mart, the Homeowner’s Policy and related entities will be loaded,
with their computed Natural Keys. John’s PERSON entity, however, will use its existing
Natural Key, and as such, will not be duplicated during the data load. Instead, the new Policy
and related entities will be linked to the existing PERSON entity, thereby reducing data
redundancy.

The sample example applies if Alamere chose to use identifying columns to compute a
Natural Key.
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FLow DIAGRAMS

The overall program flow uses Oracle Data Integrator (ODI) as the ETL tool for moving data between
schemas. The OII installation includes several packages in ODI which are used to load Warehouse
and Data Mart schemas. For the reference implementation, there is an additional package used to load
the Staging schema, however in practical application, the implementation team or customer is
responsible for designing and implementing the Staging load process. ODI is a natural choice for this
process; however the customer may have existing ETL tools and procedures that can be used as well.

It is important to note that while ETL tools provide translation capabilities as part of their
functionality, it is not recommended to perform translation on data loaded to Staging unless
absolutely necessary. If translation becomes necessary, the customer and implementation team are
advised to consider applying a similar translation to the source data so there are no discrepancies
between the source data and the data contained in OII.

The tables and processes described in the following program flow diagrams are illustrative of the
overall process. The actual program flow includes many more tables and denormalization procedures.

LOADING TO STAGING

Data from customer systems is generally maintained in one or more database management systems,
and is composed of tables that are related by one or more keys. This arrangement of data is well-
suited for maintaining transactional data for daily operations but is regarded as less than optimal for
data warehousing. As such, the initial data load to the staging environment begins the process of
denormalizing relational data. The following diagram illustrates a typical denormalization of a
customer’s relational data during the load to the staging environment.

Program Flow: Customer Data to Staging
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Figure 1: Loading to Staging Flow

The Customer Data row at the top of the diagram above illustrates multiple tables in a customer’s
enterprise data store. The leftmost cluster in this swim lane represents typical tables used for LOB-
specific transactions and business data:
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* Business Data Tables — data related LOB-specific business objects.
*  Personal Auto Policies — exemplifies an LOB-specific table housing business data.

» LOB Policies — a representative placeholder object that is used to denote other groupings of
LOB-specific tables (e.g. Homeowners Policies, Commercial Auto Policies, Umbrella
Policies, etc).

¢ Claims — data related to claims.

Note  Claims are a special case since a claim may not be related to a policy, so claims are
separate from policies.

* Transactional Data Tables — transactional data related to LOB-specific business objects.
* Personal Auto Transactions — transactions for the Personal Auto LOB.

* LOB Transactions — a representative placeholder that denotes other groupings of LOB-
specific transaction tables.

¢ Claims Transactions — transactions for Claims.

The center cluster in the top swim lane illustrates multiple tables containing information about
referenced entities in the customer’s data. In this context, an entity is an object which is referenced
in LOB-specific data. The entities may or may not be LOB-specific in this case. Typical entities are:

* External Customers (Insureds, Policyholders, Claimants)
* Internal customers (Producers, Underwriters)
*  Businesses (Insurers, Reinsurers, Suppliers)

Finally, the rightmost cluster illustrates the Earned Premium and Earned Exposure information that
may exist in a customer’s enterprise data structure.

As mentioned previous, in typical customer data structures the information contained therein is linked
with enforced key relationships to provide referential integrity between the tables. A transaction in
the LOB-Specific Policy Transaction table is related to a transaction in the Insured Information table,
as well as the Policy Information table. These tables are typically wide, meaning they contain many
columns to house the entity-specific data needed, such as name, address, contact information or
additional attributes of the policy related to the transaction. This describes the typical relational
database design that most customer data systems employ.

During the ETL process which loads the Staging environment, the key relationships are removed as
data is denormalized into a collection of tables. Policy data that is universal across LOBs is
segmented into a Policy Data table, while LOB-specific data is moved into separate tables. Data that
references parties such as Insureds and Insurance Companies, is denormalized according to the party
type (person or organization) and the role that entity plays in the transaction (Insured or Insurance
Company). Additionally, address and contact information is denormalized into postal address
information.

Of special importance is the handling of Earned Premium and Earned Exposure data. The latest
release of OII includes the ability to import these types of transactions directly to the Staging tables.
There is no denormalization that occurs during the load to Staging; instead the reporting data for
Earned Premium and Earned Exposure is loaded according to the amount and reporting time period.
It is not necessary to populate these tables — if they are left empty, OII will perform the necessary
calculations during the Staging to Warehouse flow step.
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STAGING TO WAREHOUSE

During load into the Staging schema, data is denormalized from the original references. This process
uses the aforementioned ROW_NUM construct to maintain a consistency across the tables. When
applying the denormalization across LOBs, a reduction in data redundancy can be achieved, and
hierarchical data structures can be flattened.

When data is loaded from staging into the warehouse re-normalization is applied to the data in
preparation for the final load into the fact and dimension tables in the data mart. The following
diagram illustrates a typical renormalization flow from staging to warehouse.

Program Flow: Staging to Warehouse
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Figure 2: Staging to Warehouse Flow

The top row in the diagram above shows the representative tables present in the Staging schema,
which is migrated to tables in the lower swim lane, the Warehouse schema. During the migration, the
previously denormalized data is renormalized into OII data structures. This process includes several
important steps:

*  Creating Bridge Tables

¢ Introduction of ID columns
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* Earned Exposure/Earned Premium Calculation
* Translation of relationship code
*  Separation of Addresses

Bridge tables (also called many-to-many tables) provide a relationship between two tables, and in
some cases provide additional data about the relationship. In the diagram, bridge tables are
represented by the boxes with top and left borders, whereas data tables have left and right borders.
By convention the bridge tables are generally named according to the two tables that are being joined
in the relationship. In OII, bridge tables that have “ TO_” in the name.The following example
illustrates a relationship-only bridge table:

The Ol WH.CLM_TRANS table contains a list of claims transactions. The

Oll WH.PA _VEH table contains a list vehicles referenced by Personal Auto policies. The
Oll WH.CLM TRANS TO PA VEH bridge table relates one or more vehicles in the
Oll WH.PA VEH table to a claim transaction in Ol WH.CLM TRANS.

The following example illustrates a bridge table that includes a relationship and additional data about
the relationship:

The OIl WH.PARTY table contains a list of entities. The Ol WH.PARTY ROLE table
contains a list of roles that an entity may possess. The Ol WH.PARTY TO PARTY ROLE
bridge table supplies the relationship between a Oll WH.PARTY and a

Oll WH.PARTY ROLE, while also including a time span that indicates the duration that the
entity held the role.

In the load to the Staging schema, a ROW_NUM was used to provide a virtual transaction across the
denormalized tables. When data is loaded to the Warehouse, ROW_NUM is replaced by an ID
column which is then used as a reference for rows in other tables that refer to that specific entry.

The Ol WH.PARTY table contains a list of entities. As new rows are inserted into the

Oll WH.PARTY table, OII checks that the new row is not a duplicate of an existing row.
Each row in the Ol WH.PARTY table must be unique, a characteristic enforced by the
PARTY ID primary key column. By using this method, data redundancy is eliminated — each
entity in the Ol WH.PARTY table is unique, and as new data is loaded, OII will reference
existing entities rather than creating new rows.

When Ol WH.PARTY is referenced in the Ol WH.PARTY TO PARTY ROLE bridge
table, the reference is made using the PARTY 1D column as a foreign key in the bridge table.

If the Earned Premium and Earned Exposure tables were populated in the Staging schema, the
information is simply carried over to the Warehouse and Data Mart schemas. Otherwise, OII will
calculate the Earned Premium and Earned Exposure values for use during the Warehouse and Data
Mart loads. OII supports multiple methods of calculating Earned Premium and Earned Exposure,
such as Daily, Monthly, Seasonal and Original Premium. See Metadata on page 33 in Chapter 4:
Source-to-Staging ETL for more information on the Earned Premium and Earned Exposure settings.

Note Transactions for Earned Premium and Earned Exposure have granularity to months
only. This applies to calculated and loaded Earned Premium and Earned Exposure
transactions.
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When the migration to Warehouse occurs, the relationship codes in the * RLAT CD columns are
translated into #ype codes, represented as columns named like * TYP_CD. The same hierarchical
relationships and context present in Staging are preserved during the migration to Warehouse.

In the Staging schema, addressing information is stored in the OII ST.PSTL ADDR table. During the
migration process to the Warehouse schema, the geographic boundaries present in the address are
moved into a separate table called Ol WH.GEOG BNDRY. A reference is created between the
Oll WH.PSTL _ADDR and Ol WH.GEOG_BNDRY tables using the ID scheme mentioned
previously.

WAREHOUSE TO DATA MART

The Data Mart schema is designed as a star-schema architecture with two types of tables: Facts and
Dimensions. A fact is generally recognized to be a transaction. A dimension is an attribute of a fact.
Put simply, if a transaction occurs today at noon for $5, the fact is the transaction amount ($5) and
the dimension is the date and time (today at noon).

The data model for the data mart has been designed using the normalized star schema pattern, as
opposed to the snowflake pattern. In practice, this means that the base dimension tables are linked
directly to base fact tables and are normalized to reduce redundant data. The star schema is used to
realize performance benefits offered by the database and query platform.

Note The snowflake pattern includes dimension tables that have related dimension tables,
rather than all dimensions relating directly to the fact tables.
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Figure 3: Snowflake Schema Example
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Figure 4: Star Schema Example

The Data Mart schema includes four core fact tables. Of these, two tables contain transactions for
policies and claims: Ol DM.PLCY TRANS FACT and Ol DM.CLM TRANS FACT. The
remaining two core tables contain the monthly snapshots of transaction data for policies and claims:
Oll DM.PLCY MTH FACT and Oll DM.CLM MTH FACT. Within these four core tables are all
the metrics for all LOBs. Since all metrics are part of the core tables and do not vary, the same
interface can be used to load the transaction fact tables regardless of LOB.

Through the use of LOB-specific extension fact tables, the four core fact tables are kept abstract and
generic, and LOB-specific facts are stored in the extension tables. As such, core fact tables contain
the common facts OF the related core common dimensions. This means much more efficient loading
of adapted content, ease in creation of LOBs, and allows for significantly better performance during
loads. An additional benefit is reduced storage needs, since there are no empty fact keys for unused
LOBs. Keep in mind, of course, that this design is the reference implementation only and can be
changed.

Fact-to-fact join keys are used to give a 1-to-1 extension of base fact tables to deal with LOB-
specific dimension tables. For example, the Ol DM.PLCY TRANS FACT table has an

LOB _FACT ID column. This column is used to relate the Olf DM.PLCY TRANS FACT table to
the LOB-specific table, Ol DM.PA FACT via the PA FACT ID column. The relationship
between the core fact table and the LOB-specific extension fact table is expressed by

LOB FACT ID=PA _FACT ID.

The relationship between the LOB-specific extension fact table and LOB-specific Dimension table
is expressed in the PA_VEH ID and PA_DRV ID columns. The PA_FACT ID column relates back
to the core fact table Ol DM.PLCY TRANS FACT which provides a consistent LOB-specific view
of transactions that is accommodated by the adaptive data model.
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In practice, OII uses views to present data in the dashboards. Corporate views are based on the core
fact and dimension tables — as illustrated above, the core tables are not LOB-specific and provide a
holistic view of the business without the details specific to any LOB. By contrast, the LOB-specific
views provide a holistic view of an LOB such that the core and extended fact tables appear as one
LOB-specific fact table, thus allowing a drill-down from high-level cross-LOB metrics into specific
metrics for a designated LOB.

Data loaded from the Warehouse is denormalized when loaded into the Data Mart. The following
diagram illustrates a typical denormalization flow from Warehouse to Data Mart:

Program Flow: Warehouse to Data Mart
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Figure 5: Warehouse to Data Mart Flow

As mentioned previously, transactional information from the warehouse schema is contained in
multiple normalized tables, represented in the diagram above as:

*  Business Objects (BO)
*  BO Transactions
*  BO Supporting
* LOB Objects
» Related BO Transactions to LOB Object
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* Related BO Transactions to Party
¢ Earned Premium Transactions
* Earned Exposure Transactions

The transactions in the Warehouse are denormalized into the data mart schema, using the
methodology to extend core metrics described previously, into the following types of tables:

*  Business Object Fact
*  Snapshot Fact
* Extension Fact

Similarly, normalized entity tables in the warehouse schema are denormalized into the data mart
schema as dimension tables. The denormalization process is based upon the role held by the Party —
as shown in the Party to Party Role bridge table — and as such, the parties are created in the
appropriate role-based dimension table, illustrated in the example below:

A person in the warehouse PARTY table that is related to the role of Producer will be
expressed in the PRODR_DIM table in data mart.

Additional normalization occurs with PSTL_ADDR and GEOG_BNDRY tables. As mentioned
previously the localized address information is discarded upon migration to the data mart. Regional
information is maintained and written in to the role-based dimension table. Building on the previous
example:

A person in the warehouse PARTY table has referenced CONTACT information and is also
related to addressing information in PSTL_ADDR and GEOG BNDRY. During
normalization into the data mart, the resulting row in the PRODR_DIM contains the contact
and regionalization information for the person.

Dates are also normalized into dimension tables using the following method. The tables which
contain date information are DT _DIM,MTH_DIM and TIME_DIM.

When a date value is normalized from the warehouse, the various attributes of that date are created
or referenced. All required attributes of the date, month and time are created In the DT DIM table,
the primary key is the date itself, with the additional columns used to provide attributes of the date
such as the context of the date with respect to calendar year, month and week. The same method
applies to month and time. For example:

A transaction is migrated from warehouse to data mart. The transaction effective date is
expressed as 1/1/2010 1:30:00 PM. The following information is contained in the DT DIM
table:

» DT ID=1/1/2010
» DT FULL DESC = Friday, January 1, 2010
* DAY NUM IN WK =6
* DAY NM = Fri
* DAY LONG NM = Friday
* DAY NUM IN CAL MTH =1
* DAY NUM IN CAL YR =1
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 Erc..

* MTH ID=1
* CAL MTH NM = Jan
* CAL MTH LONG NM = January
» CAL MTH NUM IN YR =1
 Erc..

» TIME ID = 1:30:00 PM
* HR 12 NM = One o’clock
* HR 24 NM =13 hrs
* HR 12 SHORT NM =1
* HR 12 NUM =1
* HR 24 NUM =13
* AM PM CD =PM
 Erc..

Currently, columns in Data Mart tables that end in “_ DT ID” relate back to the DT _DIM tables.
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Chapter 4

Source-to-Staging ETL

MASTER DATA MANAGEMENT STRATEGY

The task associated with mapping data from the client source system(s) to the OII Staging tables is
one of the most critical steps in a successful implementation. Listed below are some best practices to
use as guidance during this process.

* Data quality analysis or data profiling should be performed on the source data to ensure the data
quality and completeness for business requirements.

» Logical data mapping describes the source elements, target elements (i.e. fields in the OII Staging
tables) and any transformations that need to occur between the source and target. Transformation
rules should be stated explicitly for each target field and address any necessary data conversion.
When converting a source date to a target date column, validate that the source date is in the
expected format.

» Reconcile the count of records at the end of the loading step against the records at the end of the
transform step. This check ensures that all transformed records are accounted for and nothing is
omitted during the loading phase.

Note NULL values retrieved from the source must be set to a default value before loading the
Staging tables. The Natural Key column in each staging table is the only exception to
the “No NULLs” rule. A Nature Key must be supplied in order to support history (i.e. Type
1 or Type 2 SCDs).

METADATA

In OII, metadata refers to the data (e.g. currency conversion rates) and settings (e.g. the Earned
Premium calculation method for an LOB) that is necessary to process the transactional and
dimensional data loaded in Staging. The metadata tables include:

*  Configuration (O/I SYS schema)

e OIl SYS.SYS CONFIG — This table contains several user-configurable settings for the OIL
system.

e OIl SYS.SYS CURR_CNV - Oll loads this system table with the currency conversion data
provided by the user in the O/l ST.CURR_CNYV Staging table.

e OIl SYS.SYS ERND PREM CONFIG - Oll loads this system table with the Earned
Premium method chosen by the user per LOB. There are four methods to chose from:
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e D’ — Daily method. This method is standardized and formula-based. This is the default
method for OII.

* ‘M’ — Monthly (1/24) method. This method is standardized and formula-based.
* ‘O’ - Original Premium method. This method is standardized and formula-based.

* ‘S’ — Seasonal method. This method uses metadata that is loaded in the
OIl SYS.SYS SEASONAL CALC CONFIG table. The FORMULA CD column in the
OIl SYS.SYS ERND PREM CONFIG table will need to be loaded with one of the two
provided standardized seasonal methods (‘1° or ‘2”). The FORMULA_CD column
should contain ‘%’ for all other Earned Premium Methods, (i.e. Daily, Monthly and
Original).

OIl SYS.SYS ERND EXPO CONFIG — This table is pre-loaded with metadata that is used
for the different Earned Exposure calculation methods. These methods are standardized and
formula-based.

*  TYP_CD options are:
e ‘W’ for Written Exposure.

* ‘E’ for Earned Exposure.

*  LOB_CD: Provided to configure exposure per Line of Business.

« EXPO_BASIS_CD: This code is optional and if it is not provided it should have a value
of ‘%’

*  FORMULA_CD: For Written Exposure (TYP_CD ‘W) the options are:
e ‘I’ — Original Written Exposure amount.
e ‘2’ —Original Written Exposure amount divided by 100
e ‘3’ —Original Written Exposure amount divided by 1000

* ‘4’ — Number of days between the Transaction Effective Date and the Coverage
Expiration Date.

* FORMULA CD: For Earned Exposure (TYP_CD ‘E’) there is only one option:

* ‘1’ —The Earned Exposure amount is calculated based on the Written Exposure
amount from above.

OIl SYS.SYS RNG - This table contains system-wide range lookup metadata.

OIl SYS.SYS SEASONAL CALC CONFIG — This table is pre-loaded with seasonal-
calculation metadata that is used when the Seasonal Earned Premium method is selected.

OIl SYS.SYS XLT NM — Oll System Code Columns are pre-loaded in this table. Customer
Code Columns that need corresponding descriptions are defined by the user in this table.

OIl SYS.SYS XLT VAL — Descriptions for OII System Codes are pre-loaded in this table.
Translations and descriptions for source codes are configured by the user in this table.

Warehouse (OIl_WH schema)

Oll WH.PARTY ROLE — This table is pre-loaded with the system-defined Party Roles. For
more information, see Appendix A: Relationship Codes.
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e Dimensions (OIl_ DM schema)
Oll DM.DT DIM — This table is pre-loaded with dates from 1900 — 2099 plus dummy dates.
Oll DM.MTH DIM — OII loads this table with month information generated from the

DT _DIM table.

OIl DM.TIME DIM — This table is pre-loaded with hour information.

All Warehouse entities and data mart dimensions have a default row loaded with a dummy ID of zero

(0). These entries should remain in place once data is loaded.

REQUIRED TABLES

Listed below are the tables that are required in order for the dimension tables to be loaded correctly.

Required Staging Tables for a Policy, Earned Exposure or Earned Premium Transaction:

Oll ST.BILL ACCT (Billing Account)
OIl ST.CLASS (Class)

OIl ST.COVRG (Coverage)

Oll ST.COVRG STATUS (Coverage Status)
OIl ST.DC (Distribution Channel)

OIl ST.DED (Deductible)

OIl ST.GRP _PRG (Group Program)

OIl ST.INSUR CO (Insurance Company)
OIl ST.INSD (Insured)

OIll ST.LMT (Limit)

Oll ST.LOB (Line of Business)

OIl ST.PLCY (Policy)

Oll ST.PRODR (Producer)

OIl ST.REINS CNTRCT (Reinsurance Contract)
OIl ST.REINS CO (Reinsurance Company)
Oll ST.UW (Underwriter)

Required Staging Tables for a Claims Transaction:

Oll ST.BILL ACCT (Billing Account)
OIl ST.CAT (Catastrophe)

OIl ST.CLASS (Class)

Oll ST.CLMT (Claimant)

OIl ST.CLM _ADJ (Claim Adjuster)
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*  OIl ST.CLM EXAMR (Claim Examiner)

*  OIl ST.CLM MGR (Claim Manager)

*  OIl ST.CLM (Claim)

* OIl ST.COVRG (Coverage)

*  OIl ST.COVRG STATUS (Coverage Status)
* OIl ST.DC (Distribution Channel)

* OIl ST.DED (Deductible)

* OIl ST.FEAT (Feature)

»  OIll STFEAT STATUS (Feature Status)

* OIl ST.GRP _PRG (Group Program)

* OIl ST.INSD (Insured)

* OIl STINSUR CO (Insurance Company)

* OIl ST.LITG (Litigation)

*  OIl ST.LMT (Limit)

* OIl ST.LOB (Line of Business)

* OIl ST.PLCY (Policy)

* OIl ST.PRODR (Producer)

* OIl ST.REINS CNTRCT (Reinsurance Contract)
* OIl ST.REINS CO (Reinsurance Company)
* OIl ST.SUPPLIER (Supplier)

*  OIl ST.UW (Underwriter)

DATA VALIDATION

OlII supports data validation in line with the ETL processes. OII supports two types of data validation:
Code Lookup Validations and SQL Validations. Data validation is performed in ODI prior to loading
any data to the Warehouse or Data Mart schemas. This process is critical to ensure the data quality

and completeness for business requirements. The data validations listed below are pre-loaded in OII.

* Code Lookup Validations:
« LOB CD
« PLCY _TRANS CD
« CLM_TRANS CD
e SQL Validations:
*  BOOK DT must be greater than or equal to SRC_SYS PROC DT.
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+  BOOK DT must be greater than or equal to TRANS EFF DT.

«  PLCY_EFF DT must be less than or equal to PLCY EXPR DT.

*  COVRG_EFF_DT must be less than or equal to PLCY _EXPR_DT.

*  COVRG_EXPR DT must be equal to PLCY EXPR DT.

*  COVRG_EFF DT must be greater than or equal to PLCY EFF DT.

There are several OIl_SYS tables that are used to facilitate the Data Validation:

 OILSYS.SYS_VALIDATE_CD:

e This table defines all code-based validations.

*  The PROC _TYP FLG column is used to enable/disable each validation. A value of ‘V’
indicates a validation is enabled and a value of ‘X’ indicates a validation is disabled.
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OII_SYS.SYS_VALIDATE_SQL:

» This table defines all SQL based validations.

*  The PROC _TYP_ FLG column is used to enable/disable each validation. A value of ‘V’
indicates a validation is enabled and a value of ‘X’ indicates a validation is disabled.
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The Data Validation can be executed from a pre-defined ODI Package or it can be executed directly

from ODI:

« Data Validation is integrated into the ODI Package — Warehouse Load Conditional.
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Figure 8: Data Validation
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» To directly execute the Data Validation from ODI, locate the DATA VALIDATION Scenario,

right mouse click and select Execute from the menu.
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Figure 9: Execute Data Validation from ODI
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If there are data validation errors, the Operator console will show the error as shown in the figure
below.

B [Local] Oracle Data Integrator 11g
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Figure 10: Data Validation Errors

The table, OIl_SYS.VALIDATION ERROR LOG, contains details of validations errors. Using
this information, further analysis on the staging data can be performed.
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Figure 11: Oll_SYS.VALIDATION_ERROR_LOG
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With this example the validation error indicates a failure with translating an LOB_CD value of
‘HOM’. With this type of error, you will need to verify that the staging data contains a code value
that is represented in the OIl_SYS.SYS XLT VAL table,
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Figure 12: Failure in Translating the LOB_CD Value

With this example, the validation process has identified at least one row of data in the Ol ST.LOB
table with an invalid LOB_CD value of ‘HOM’. This value should be ‘HOME’ which translates to
the ‘Homeowner’ line of business with a SYS CD VAL of ‘HO’. This error must be corrected in
staging before the data is allowed to be loaded into the warehouse.
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DATA RELATIONSHIPS

UNIQUE KEYS

In the staging tables, there are specific transactions for Policies, Claims, Earned Premiums and
Earned Exposures. For Ol ST.PLCY and OII ST.CLM tables natural keys are used to uniquely
identify a policy and a claim. Natural keys are discussed in detail in Chapter 3: Program Flow.
Unique keys are used to connect Policy, Claim, Earned Premium and Earned Exposure transactions
within the warehouse tables.

* OIll WHPLCY TRANS

* Includes PLCY_TRANS ID to uniquely identify a specific policy transaction.
Ol WH.CLM TRANS

e Includes CLM_TRANS ID to uniquely identify a specific claim transaction.

* Includes PLCY_ID to establish a relationship between a specific claim transaction and its
matching policy.

« Ol WH.ERND PREM TRANS

e Includes ERND PREM TRANS ID as well as PLCY TRANS ID to create the
relationship between a specific Earned Premium transaction and its matching policy
transaction.

 OIll WHERND EXPO TRANS

* IncludesERND_EXPO TRANS IDaswellasPLCY TRANS ID to create the relationship
between a specific Earned Exposure transaction and its matching policy transaction.

COMMON/SHARED KEYS

In the staging environment, there are four possible types of transactions that can be loaded from the
customer data: Policy Transactions, Claim Transactions, Earned Premium Transactions and Earned
Exposure Transactions. The staging table that is critical in making a connection between all of these
transactions is the Ol ST.PLCY. For each of the previously mentioned transaction types, a unique
policy should be associated with that transaction.

When the data from the table Ol ST.PLCY is loaded to the warehouse, A POLICY ID and a
POLICY_TRANS ID is generated in the table O/l WH.PLCY TRANS. The POLICY ID is shared
between the tables Ol WH.PLCY TRANS and Oll WH.CLMS TRANS, creating a connection
between a specific claim and its matching policy. The POLICY TRANS ID is shared between the
tables Ol WH.PLCY TRANS and Ol WH.ERND PREMIUM as well as

Oll WH.ERND EXPOSURE, creating a connection between a specific Earned Premium and
Earned Exposure transaction and its matching policy.
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DATA LOADING CONSIDERATIONS

In coding the Source-to-Staging ETL, it is important to know how OII expects the transactions to
relate to one another and the policy as a whole. One of these considerations is how to distribute
premium in a Personal Auto Policy.

PERSONAL AUTO PREMIUMS

In the Personal Auto LOB, each transaction has one associated driver. If that transaction includes any
Written Premium, it will be assigned to the vehicle and/or driver associated with that transaction.

In order to perform premium or loss analysis in Personal Auto at the Vehicle and/or Driver level (i.e.
a sub-policy level), the premium should be apportioned across multiple transactions. The premium
assigned to that transaction will be associated with the particular vehicle and/or driver for that
transaction when the data is loaded into the Staging tables. Transactions loaded with zero premium
will not assign any premium to the vehicle and/or driver associated with that transaction, so sub-
policy level analysis will not be available.
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Data Loading

After the Source-to-Staging ETL has loaded the transactional data, the OII system is ready to be
configured to handle the customer data, loaded and prepared for presentation to the end user. The
Data Loading chapter introduces the OII System Codes that control processing of transactions, load
configuration options, currency configuration, load execution and OBIEE Repository linkage.

SYSTEM CODES

System Codes are functional codes in OII that tell the system how to route and process transactions.
System Codes are defined in the OII_ SYS.SYS XLT NM table. System code translations and
description are contained in the OII SYS.SYS XLT VAL table. Four categories are covered:

Claim Transaction Code (CLM_TRANS_CD) — This system code represents what type of loss
activity occurred in the claim transaction. The functional codes supplied with OII cannot be
changed. They are described below. Additional Claim Transaction Codes can be added by the
user to group related transaction types, but these transactions will never be included in the
monthly snapshot data marts.

Line Of Business Code (LOB_CD) — This system code identifies the LOB classification. By
default, there is a single code defined for each of the six pre-defined LOBs. Additional Line of
Business Codes can be set by the user in Warehouse Palette. When an LOB is published, its code
is added to the OIl_ SYS.SYS XLT VAL table.

Policy Transaction Code (PLCY_TRANS_CD) — This system code identifies the policy
transaction. The functional codes supplied with OII cannot be changed. They are described
below. Additional Policy Transaction Codes can be added by the user to group related transaction
types, but these transactions will never be included in the monthly snapshot data marts.

45



Chapter 5 — Data Loading

SOURCE CODE TRANSLATION AND DESCRIPTION

In addition to providing descriptions for the pre-defined OII System Codes, the
OIl_SYS.SYS_XLT VAL table translates client source codes present in the Staging data into OII
System Codes. No additional configuration is needed in the OII_SYS.SYS XLT NM table if a
source code is being translated to one of the three System Codes defined above.

If descriptions are needed for source codes outside of the three categories above, an entry is needed
in the OI_SYS.SYS _XLT NM table to define the staging table and column that are being
translated. The target code and description columns are also defined here. Source codes are
translated and described in the OI_SYS.SYS XLT VAL table exactly as it is done for the System
Codes.

IMPORTANT Translations and descriptions for client source codes must be provided before loading
Staging data to the Warehouse. If transactions have already been loaded to the
Warehouse, changes to the translations and descriptions will only affect transactions
loaded after those changes have been made.

CLAIM TRANSACTION CODES

Claim Transaction Codes are required to process claim transactions correctly. These codes also allow
for the proper display of claim transaction types in OBIEE. There are currently 19 Claim Transaction
Codes.

These consist of three basic categories of transactions:
* Reserve — The initial reserve set up on a claim, including the initial reserve on a reopened claim.

* Change — Any change in reserves on a claim, including the final reserve transaction (eliminating
the loss reserve) in a closed or reclosed claim.

* Paid/Recovered — Any paid amounts on a claim, including any financial adjustments or
modifications to paid losses. This also includes any recoveries made for Salvage, Subrogation or
Deductible.

For each category, there are six claim transaction types:
» Loss — Amounts reserved, paid or recovered in relation to the settlement of the claim.

e Allocated Adjustment Expense (ALAE) — Amounts reserved, paid or recovered in relation to
adjustment expenses specifically allotted to a claim.

* Unallocated Adjustment Expense (ULAE) — Amounts reserved, paid or recovered in relation
to adjustment expenses that are not specifically allocated to a claim. These amounts are not
usually used on a claim transaction basis, but rather on a financial accounting basis.

» Salvage — Amounts reserved, paid or recovered in relation to property collected as salvage in the
settlement of a claim.

* Subrogation — Amounts reserved, paid or recovered in relation to reimbursement from a third
party responsible for damage or liability in the settlement of a claim.

* Deductible — Amounts reserved, paid or recovered in relation to reimbursement of a deductible
in the settlement of a claim.
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In addition to these eighteen codes, there is a special code that does not fit into the categories above.

* Non Financial — The Non Financial code allows for a transaction to be entered without affecting
the reserve amount. When loaded, the transaction is available in the transaction data marts, but it
will never be included in the monthly snapshot data marts.

The 19 functional Claim Transaction Codes are grouped in the three categories (Reserve, Change
and Paid\Recovered) along with the special Non Financial code below:

Claim Transaction Type Code Description

Loss Reserve LR Initial or reopened Expense Reserve

Allocated Expense Reserve AR Initial or reopened ALAE Reserve

Unallocated Expense Reserve UR Initial or reopened ULAE Reserve

Salvage Reserve SR Initial or reopened Salvage Reserve

Subrogation Reserve RS Initial or reopened Subrogation Reserve

Loss Deductible Recovery Reserve DR Initial or reopened Deductible Reserve

Loss Change LC Change in Loss Reserve

Allocated Expense Change AC Change in ALAE Reserve

Unallocated Expense Change ucC Change in ULAE Reserve

Salvage Change SC Change in Salvage Reserve

Subrogation Change RC Change in Subrogation Reserve

Loss Deductible Change DC Change in Deductible Reserve

Paid Loss PL Paid Loss Amount

Allocated Expenses Paid AE Paid ALAE Amount

Unallocated Expenses Paid UE Paid ULAE Amount

Salvage Recovered SL Recovered Salvage Amount

Subrogation Recovered SB Recovered Subrogation Amount

Loss Deductible Recovered DE Recovered Deductible Amount

Non Financial NF Non-Financial Amount (may be zero or
non-zero dollar amount)

PoLicYy TRANSACTION CODES

Policy Transaction Codes are required to process premiums and policy transactions correctly. Like
the claim codes, the policy codes allow for the proper display of policy transaction types in OBIEE.
There are currently 9 Policy Transaction Codes.

Policy Transaction Type Code

Additional Premium Audit AP
Cancelled Flat CF
Cancellation CN
Cancelled Other CcO
New Business NB
Non-Premium Endorsement NP
Renewal Business RB
Reinstatement Business RE
Return Premium Audit RP
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LOAD CONFIGURATION

The load parameters listed below are found in the OI SYS.SYS CONFIG table. These values
should be set prior to executing the data load in ODI.

ANALYSIS OPTIONS

Code Names: ANALYZE WH, ANALYZE DM

Description: These parameters determine if the warechouse and/or data mart need to be analyzed
as part of internal loading (ETL) process. A “Y” value (default) will invoke the analysis process
(dbms_stats) as part of ETL. Oracle recommends running stats on a regularly scheduled basis.
The analysis option is provided as a way to automate this feature. The analysis options are used
in the packages below:

Load Warehouse Entities and Transactions
Load Monthly Snapshot Facts

Load Data Mart Dimensions and Transactional Facts

CURRENCIES

Code Names: LOCAL CURR, GLOBAL CURR 1, GLOBAL CURR 2, and
GLOBAL CURR 3

Description: These parameters define the Local Reporting Currency (i.e. the default currency;
LOCAL_CURR) and the optional Global Reporting Currencies. Up to three Global Reporting
Currencies can be defined (i.e. GLOBAL CURR 1, GLOBAL CURR 2 and

GLOBAL CURR 3). Transaction amounts are input to the OII system in as Document
Currency. The Local Reporting Currency and the Global Reporting Currencies can be utilized
along with the currency conversion rate data (see Currency Configuration on page 51) to convert
the Document Currency to the corresponding Reporting Currency equivalents.

Example Value: “USD”

DEFAULT BEGIN DATE

Code Name: DFLT BEGIN DT

Description: This date represents the lowest date value that the system can support. This value
will also serve as a default date value if an input date is NULL. The date format “MM-DD-
YYYY” is recommended. The format of the value needs to match the DFLT DT FORMAT
value.

Example Value: “01-01-0001”
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DEFAULT DATE FORMAT
*  Code Name: DFLT DT FORMAT

* Description: Default date format for the system. The date format “MM-DD-YYYY” is
recommended.

DEFAULT DATE/TIME FORMAT
+  Code Name: DFLT DT TIME FORMAT

* Description: Default date time format. The format “MM-DD-YYYY HH24:MI:SS” is
recommended.

DEFAULT END DATE
*  Code Name: DFLT END DT

e Description: This is the default end date for the system. This date will be used to mark the end
date of active record in case of slowly changing record. The format of the value needs to match
the DFLT DT _FORMAT value.

* Example Value: “12-31-9999”

DEFAULT NUMERIC VALUE
*  Code Name: NUM_DFLT VAL

*  Description: The Default Numeric Value should be supplied for any numeric field in Staging
when no data is available from the source system. If the value supplied matches the Default
Numeric Value, OII knows to treat this field as having no data. NUM_DFLT VAL must be a
single digit number.

* Example Value: “0”

DEFAULT STRING VALUE
*  Code Name: STR DFLT VAL

* Description: The Default String Value should be supplied for any string field in Staging when
no data is available from the source system. If the value supplied matches the Default Numeric
Value, OII knows to treat this field as having no data. STR_DFLT VAL must be a single
character and cannot be a single quote character.

[T

* Example Value:

INCURRED LOSS CALCULATION METHOD

* Code Name: INCRD CALC METH is the Incurred Loss Calculation Method, value 1 — 5,
default is 1

e Description: The following options are available.
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¢ Method 1: Loss Reserve + Paid Loss

*  Method 2: Loss Reserve + Paid Loss + Salvage + Salvage Reserve + Subrogation +
Subrogation Reserve

*  Method 3: Loss Reserve + Paid Loss + Salvage + Salvage Reserve + Subrogation +
Subrogation Reserve + Deductible + Deductible Reserve

e Method 4: Loss Reserve + Paid Loss - Salvage + Salvage Reserve - Subrogation +
Subrogation Reserve + Deductible + Deductible Reserve

*  Method 5: Loss Reserve + Paid Loss + Salvage + Subrogation + Deductible

INCURRED LOSS WITH EXPENSE CALCULATION METHOD

Code Name: INCRD WEXPNS CALC METH is the Incurred Loss with Expense Calculation
Method, value 1 — 2, default is 1

Description: The following options are available.

e Method 1: Incurred Loss + Allocated Expense + Allocated Expense Reserve + Unallocated
Expense + Unallocated Expense Reserve

*  Method 2: Incurred Loss + Allocated Expense + Allocated Expense Reserve

LATE ARRIVING METHODOLOGY

Code Name: LATE ARRIVING METH

Description: This parameter determines the loading method to be used. The loading methods
listed below are supported.

e Method 1: Ignore Late-Arriving Transaction. Load the regular transactions.

*  Method 2: If there are Late-Arriving Transactions, stop the load and wait for user
intervention to continue. Otherwise, continue as normal.

*  Method 3: Load Late-Arriving Transactions but do not delete/reload Earned Premium/
Earned Exposure/MTH_SNAP_SHOT for the affected period.

*  Method 4: Load Late Arriving Transactions and automatically reload Earned Premium/
Earned Exposure/MTH_SNAP_ SHOT for the affected period.

LoG NAME/PATH

Code Name: LOG _FILE NM PATH

Description: Path and File name of the OS log file to be generated in case of late arriving
notification. File will be created on the machine hosting the ODI AGENT, hence path should be
for the machine hosting agent responsible for invoke the processes.
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CURRENCY CONFIGURATION

OII supports loading transactional amounts in an unlimited number of Document Currencies and
reporting in up to four Reporting Currencies.

Transactions are always loaded in denominations of the Document Currency that is defined at the
transactional level. For claim transactions, a code for the Document Currency is entered in the
DOC CURR _CD column of the OII_ST.CLM_TRANS (Claim Transaction) table. If a policy
transaction, Earned Exposure transaction or Earned Premium transaction is loaded, a code for the
Document Currency must be entered in the DOC_CURR_CD column of the OII_ST.PLCY_ TRANS
(Policy Transaction) table.

OII can support up to four Reporting Currencies: one Local Reporting Currency (LOCAL CURR)
and up to three additional Global Reporting Currencies (GLOBAL CURR 1, GLOBAL CURR 2
and GLOBAL CURR _3), as defined above under “Currencies.”

A daily exchange rate must be entered for the Document Currency and each Reporting Currency that
is defined. This exchange rate data is transferred to the OIl_SYS.CURR_CNV (Currency
Conversion) table whenever the warehouse tables are loaded. See Load Execution on page 55 for
definitions of which scenarios involve loading warehouse tables.

DEFAULT CURRENCY CONVERSION RATES

Before loading the warehouse tables for the first time, the

OIl ST.LOAD DEFAULT EXCHANGE RATE procedure should be executed for any currency
that is both a Document Currency and a Reporting Currency. This will populate the necessary rows
in the OII_ST.CURR_CNYV table so that conversion rates will not need to be loaded to convert a
currency to itself. Executing this procedure sets the self-to-self conversion rate at 1 for the specified
time span.

Connect to the OII_ST schema in Oracle SQL Developer. Under Procedures in OIl_ST, find the
LOAD_DEFAULT _EXCHANGE_ RATE procedure, as shown in Figure 13 on page 52.
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Figure 13: The LOAD_DEFAULT_EXCHANGE_RATE Procedure

The inputs are:

A (=N (2] 4] LowD_DEFALLT_EXCHANGE RATE =
@Y Cod| Granks |Deperdencies |References | Detals |Exeation Profies
-3 Connections ~| A 7 ) actions..,

create or replace PROCEDURE LOAD_DEFAULT EXCHANGE RATE (io_defaulr currency code VERCHARZ, io_sta™
15

Author

1 number of davs
£l

WUMEER ;

[ElRunning - Log
Connecting to the database OII_ST.
Digconnecting frem the databare 0II_ST.

Mszages | DataEdtor | [BRunning 1

(SH 5L History

10 DEFAULT_CURRENCY_CODE - This is the Reporting Currency Code (e.g. ‘USD’ or

‘GBP”) as defined in the OII_SYS.SYS CONFIG table.

10_START YEAR -

This numeric value specifies the year from which the default conversion

rate needs to be generated.

I0_END_YEAR - This numeric value specifies the year to which the default conversion rate
needs to be generated.

When specifying a start year and end year, select years that encompass the entire historical and
future reporting period. This will populate all necessary conversion rate data for the currency so that
this procedure only needs to be run once.
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Right click on the procedure, LOAD DEFAULT EXCHANGE RATE, and select Run. The Run
PL/SQL dialog box will appear.

F Run PL/SOL

Parameters: . _

LOAD _DEFAULT_EXCHANGE_RATE Parameter Data Type Mode
10_DEFAULT_CURRENCY CODE VARCHARZ(200) N
10 _START_YEAR MUMEBER N
10 _END_YEAR. MUMEER. N

PL/SQL Block

DECLARE £

10 DEFAULT CURRENCY CODE VARCHRRZ2 {200);
I0_START YEAR HUMBER;
I0_END_YEAR WUMBER:

BEGIN
10_DEFAULT_CURRENCY CODE := MULL:

I0_START_YEAR := NULL;

LOAD DEFAULT EXCHANGE RATE(
I0_DEFAULT CURRENCY CODE => I0 DEFAULT CURRENCY CODE,
I0_START YEAR => I0_START YEAR,
I0_END_YEAR => I0_END_YEAR

W

¢ 5
? Save File, ., l Frorm File, .. I Resat l

‘I/ o || coeal |

Figure 14: Run PL/SQL Dialog Box

Replace the NULL values with the desired values, as shown in the highlighted inputs above. Click
the “OK” button to run. Note that the [0 DEFAULT CURRENCY_CODE input value will need
single quotes (e.g. ‘USD’) because it is a VARCHAR?2 data type.

MULTIPLE CURRENCIES AND CONVERSION RATES

If a single currency is used for the Document Currency and the Reporting Currencies, loading the
default currency conversion rate is sufficient. If transactional amounts will be reported in currencies
other than the currency used for loading, daily conversion rate data will need to be provided for each
Document-Currency-to-Reporting-Currency pair.

If needed, daily currency conversion rate data is loaded in the OIl_ ST.SYS CURR_CNYV (Currency
Conversion) table. The columns in the OIl_ST.SYS CURR _CNYV table are listed below:

* CURR_CNV_DT - This is the date for which the exchange rate applies.

53



Chapter 5 — Data Loading

*  CURR_CNV_FROM_CD - This is the code for the Document Currency (e.g. USD or GBP).
This code will be defined in the OII_SYS.SYS CONFIG table if it is also a Reporting Currency.
Otherwise, Document Currency codes will only appear in the DOC_CURR_CD column of the
appropriate transaction table and here, in the OI_ST.SYS CURR_CNYV table.

* CURR_CNV_TO_CD - This is the code for the appropriate Reporting Currency as defined in
the OII_SYS.SYS CONFIG table (e.g. EUR or INR).

*  CURR_CNV_RATE - This numeric value represents the coefficient multiplied by the
Document Currency (CURR_CNV_FROM CD) to produce an equal value in terms of the
Reporting Currency (CURR_CNV_TO CD).

Loading of the OII_ST.SYS CURR_CNYV table with daily currency conversion rates should be
incorporated into or alongside the Source-to-Staging ETL process that loads transactional data.

#, Oracle SQL Developer : Table OII_SYS.SYS_CURR_CNV@OII_SYS_DER

File Edit View Mavigate Run Versigming Yool Help
Gedg 90 EH O-0- & o
B x/ (@ x [ @rotide x |[Blon_srsper x ([EHsws cmr cmv x =
4T Columns Data Constraints | Grants | Statistics | Triggers | Flashback | Dependencies | Details | Partitions | Indexes |SQL ]
B, Connections 2 A EHEXEE Filter:  Actions...
=B on_com B srs_.. @' comr_ow...|§ curr_cnv_From || curr_onv_To ([§ CLRR_UN_RATE|
- on_om [ =] 31-DEC-99 usD EUR 1.36992
w B oMt =2 5627 30-DEC-99 usD ETR 1.36992
: g g::l[:::p *3] &s9se 29-DEC-98 usD EUR 1.36992
= i@ omsvs. =4| 24198 28-DEC-98 USD EUR 1.36992
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@& Quew,
— 00|

Figure 15: OIl_SYS.SYS_CURR_CNV Table
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LOAD EXECUTION

Several execution options are available to load OII. The scenarios listed below can be executed to

load the appropriate layers of the OII data model.

COMPLETE LOAD
The COMPLETE LOAD scenario loads the Warehouse, Dimensions, Transactional Fact tables and

the Monthly Snapshot Fact tables.

~ Projects 5 -
=-fyon
[+-1, ZJCONFIG
& ;_._JDM
=L WH
- [ ZJENTITY LOAD
-4 A TRANSACTION LOAD
= B Packages
& ,_T-E)Clean Execution Log
= 3] Complete Load
= 'h Steps
= Scenarios
= ‘33 COMPLETE_LOAD Yersion 001
- H variables
1'3’:] Executions
v B Scheduling

Figure 16: Complete Load
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WAREHOUSE LOAD

The WAREHOUSE LOAD_CONDITIONAL scenario loads the Warehouse tables. This scenario
is useful in debugging the data produced from the Source-to-Staging ETL..

* Projects m =
=y o
-, JJCONFIG
£ '._,:,i DM
= '._,:,i WiH
| JJENTITY LOAD
|, ) TRANSACTION LOAD
=B Packages
- 34 Clean Execution Log
- 34 Complete Load
¥ 44 Data validation
- 34 Load Earnings LOB
¥ 34 Load Earnings LOB Conditional
- I Load Warehouse Entities and Transaction
- 34 Motification
- 3 Refresh All Global Variables
= warehouse Load Conditional
=By Steps
=54 Scenarios
= FE WAREHOUSE _LOAD_CONDITIONAL Yersion 001
= & variables
H3GLOBAL.G_DFLT_BEGIN_DT
5 GLOBAL.G_DFLT_DT_FORMAT
H3GLOBAL.G DFLT_DT_TIME_FORMAT
H5GLOBAL.G_LATE_ARRIVING_FLG
&5 GLOBAL.G_LATE_ARRIVING_METH
S on.L_cLM_TRANS_EFF_DT
E50OILL_NUM_MTHS_PLCY_TRANS
HHOILL_PLCY_TRANS_EFF_DT
S OILL_PLCY_TRANS_START_YR_MTH
#) Executions
-] Scheduling

Figure 17: Warehouse Load

56



Load Execution

DATA MART LOAD

The LOAD_DATA MART_DIMENSIONS AND FACTS scenario loads the Dimensions,
Transactional Fact tables and the Monthly Snapshot Fact tables. This scenario can be used to

complete the loading after the Warehouse Load has been executed.

 Projects

=-fyon
E-L JCONFIG
=-{30M
b, ADIMENSION LOAD
& | JFACT LOAD
= B Packages
& ,jEH OM Load Claim Manthly Snapshot Conditional
= EDM Load Palicy Maonthly Snapshot Conditional
=) 39 Load Data Mart Dimensions and Facts
My Steps
= Scenarias
= EFLoAD_DATA_MART_DIMENSIONS_AND FACTS Version 001
=)-Ef Varlables
{1} OILL_NUM_MTHS _CLM_TRANS
- EHOILL_NUM_MTHS_PLCY_TRANS
H3OILL_PLCY_TRANS_START_YR_MTH
) Executions

'ﬁ Scheduling

7 -

Figure 18: Data Mart Load
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DIMENSIONS AND TRANSACTIONAL FACTS LOAD

The LOAD_DATA_ _MART_DIMENSIONS AND FACTS DAILY scenario loads the
Dimensions and the Transactional Fact tables. This scenario can be used after the Warehouse Load_
whenever the Monthly Snapshot Fact tables are not ready to be loaded. This may be the case if
routine loads are performed multiple times within a given month.

= Projacks E'j -
=By on
- CONFIG
SR [y
;_,_]DIMEI"-.ISIOI"-.I LOdD
| JFACT LOAD
= B Packages
[+ 3 DM Load Clain Monthly Snapshot Conditional
- 59 DM Lead Policy Manthly Snapshot Conditional
it/ 3] Load Data Mart Dimensions and Facts
= 39 Load Data Mart Dimensions and Transactional Facts
- ey Steps
=3 Scenarios
=3 L0AD_DATA_MART_DIMENSIONS_AND_FACTS_DAILY Version 001
l:Tuir Variables
] Executions
&5 Scheduling

Figure 19: Dimensions and Transactional Facts Load
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MONTHLY SNAPSHOT FACTS LOAD

The LOAD_MONTHLY_SNAPSHOT scenario loads the Monthly Snapshot Fact tables. This

scenario can be used to populate the Monthly Snapshot Fact tables after the Warehouse, Dimensions
and Transactional Fact tables have been loaded.

= Projects -
=-fyon
- CONFIG
=M
(1, DIMEMSTON LOAD
-1 _JFACT LOAD
=B Packages
- 34 DM Load Claim Monthly Snapshot Conditional
#-3 DM Load Policy Monthly Snapshot Conditional
#-  Load Data Mart Dimensions and Facts
] HLmad Diata Mart: Dimensions and Transactional Facks
=3 Load Monthly Snapshot
- By Steps
=39 scenanos
= LOAD_MONTHLY_SNAPSHOT Version 001
&5 variables
a_l Executinns
H¥] Scheduing

Figure 20: Monthly Snapshot Facts Load

LOAD SCHEDULING

Each of the above mentioned Scenarios can be scheduled. A schedule for a scenario will have to be
defined and configured in Oracle Data Integrator. Within the help section of Oracle Data Integrator
there are detailed instructions on how to define and configure a schedule. Schedules are attached to
specific scenarios in Oracle Data Integrator. These schedules are managed by the scheduler built-in
run-time agent. Each Schedule allows a start date and a repetition cycle to be specified.
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CLEARING THE OBIEE CACHE AT THE END OF THE DATA LOAD

Once you have completed the load process you should purge the OBIEE cache to improve
performance. To do so, follow the steps below.

1. Create afile, (e,g, purgecache.txt) which contains the following command:

Call SAPurgeAllCache()

2. Run bi-init.cmd (or bi-init.sh on UNIX) from the following location:

<MW_HOME>/instances/<instance number>/bifoundation/OracleBlApplication/coreapplication/setup

3. Run the nqemd utility to purge the OBIEE cache:

ngcmd -d my dsn -u my username [-p my password] -s sqgl input file

Where:

* my_dsn - is the ODBC connection name for the BI Server.

* my_username - is the WebLogic admin user name.

* my_password - is the password.

e sql _input file - is the full path of the file you created in step 1 (e.g. purgecache.txt)..
For example:

In Windows:

ngcmd -d AnalyticsWeb -u <weblogic admin user> -p <weblogic admin
password> -s purgecache.txt

In Unix:

./ngcmd -d AnalyticsWeb -u <weblogic_admin user> -p <weblogic_admin password> -s
purgecache.txt
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Data Visualization

OBIEE REPOSITORY

OII offers pre-defined OBIEE subject areas that match each LOB reference implementation in
Warehouse Palette. Any modifications to the reference implementation must be manually updated in
the OBIEE Repository.

Any UDFs that are utilized and contain data will need to be added to the presentation layer in the
OBIEE Repository in order for them to be available to the end user in the reports and dashboards.

Please reference the following manuals in the OBIEE documentation set:
*  Oracle Business Intelligence Server Administration Guide
*  Oracle Business Intelligence Presentation Services Administration Guide

*  Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User Guide
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OBIEE REPOSITORY LINKAGE

Once data has been loaded to the Data Mart schema, the OII data model must be linked to the OBIEE
Repository before logging into OBIEE Analytics to view the data. This section details those steps.

Step 1: Open the OBIEE Repository
1. Open the OBIEE Repository Administration Tool by selecting:

IMPORTANT In the case that an LOB was created that was not included in the six that are available
out of the box there are a number of steps that need to be performed in order to have

that LOB included in the AnalyticsWeb repository.

If this is the case then skip to OBIEE Repository Linkage for New or Updated LOB on
page 71. Complete the steps in that section before executing the steps in this section.

Start>All Programs>Oracle Business Intelligence>Administration

2. When the Administration Tool opens, select File>Open>Online to display the Online

Repository dialog box.

W

welcomel) and click on OK.

In the login dialog box that appears, enter the Repository Password (the default password is

4. Enter a valid User Name and Password. The default user name is weblogic and whatever
password you selected when you installed OBIEE.

The following Repository screen will open:

# ([l Clam Transaction
[ Commicil Audo

+ [f]ﬂ Commercial Propedty
% [}l Coupoeere Chetad

e l.fﬂ Doty Fuie

+ [l Momecwmens

% [ Peisonal fako
[l Peisonsl Umbrela
[l Pobcy Transaction

Presentation |
[ () ComMortbhSowpsht. =~~~ [|= &9

=l Peisonal Umbnels

- () Commercial Auto
+ [ Commercid Property
7 [ Cosporste
# [B DweelingFee
o [ Homeowser
- [ IntsghiM0Contg
+ [ Pessonal dute
4 [ Pesonal Unkeela

Figure 21: Layers of the OBIEE Repository for Oll
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Step 2: Configure the Line of Business Subject Areas

1. Go to the Physical Layer pane. This pane contains the Subject Areas for each Line of Business
(Commercial Auto, Homeowners, etc.) and an additional Subject Area called Insight700Config.
You will need to configure the settings under each of the Line of Business Subject Areas and the
Insight700Config Subject Area.

Important The following configuration steps apply only to the Subject Areas for each Line of
Business. The steps to configure the Insight700Config Subject Area are on page 67.

2. Expand each of the Line of Business Subject Areas under the Physical Layer pane. The
Connection Pool icon will appear underneath each Subject Area:

Physical ]

o O [y

5 Connection Pool

#- 5 Oll_DM

= Commercial Property

----- a Connection Pool

#- 5 Oll_DM

=B Corporate

----- a Connection Pool

#- 5 Oll_DM

=13 Dwelling/Fire

----- a Connection Pool

#- 5 Oll_DM

= Homeowners

----- a Connection Pool

#- 5 Oll_DM

- Insight?00Canfig

= Personal Auto

----- a Connection Pool

#- 5 Oll_DM

=B Perzonal Umbrella
----- a Connection Pool
#- 5 Oll_DM

Figure 22: Subject Areas under the Physical Layer
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3. Starting with the Commercial Auto Subject Area, click on the Connection Pool icon.

=3 Commercial Auta
P a Connection Pool

% Oll_DM

Figure 23: Connection Pool Icon
4. A message box will appear and ask you if you want to check out the Connection Pool.

5. Select Yes. The Connection Pool screen opens:

Connection Pool - Connection Pool _ (O

"Wiite Back | Mizcelaneous I Aggregate Persistence I
General I Connection Scripts I #ML
Marme: Connection Pool Pemmizzions. .. |

Call interface: [oc1100/114 =]
M amirum connections: I 103: [ Persist aggregates as Analytic Workspace
[ Eequire fully qualified table names

[ ata source name; IINSIEHT?EIEI
¥ Shared logon

Uzer name: IEIII_DM Pazzword: I—
¥ Enable connection pooling

Timeout; |5 I [miFiLkes] j

¥ Usze multithreaded connections

¥ Parameters supported

lzalation level: I D efault j

Deszcrption:

=

| )4 I Cancel | Help |

Figure 24: The Connection Pool Screen
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6. Make sure that the Require fully qualified table names option is unchecked.

7. Under the “Shared Login” section, enter the same user name and password that you entered on
the Schema Configuration Parameters screen for the Data Mart Schema (see the Oracle
Insurance Insight Installation Guide).

# Oracle Universal Installer; Specify Insight Scherna Configuration Paramelers

Specify Insight Schema Configuration Parameters Mo R ANCE
Oracle Insurance Insight 7.0.0

Figure 25: Data Mart Schema User Name and Password on the Schema Configuration Parameters Screen

Note The default user name is Oll_DM. If you entered a different user name on the Schema
Configuration Parameters screen, use that name here.

8. Leave all of the other settings as is and click OK to close the screen.
9. To ensure the user name and password entered in step 7 above is correct:
a. Open any table under one of the Subject Areas.

b. Right click on the table you selected and choose ‘Update Row Count’. You will be
prompted to check out the table’s objects-
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¢. Click “Yes’.

Mew Objeck 3

pdate Ro

Views Data. ..

Display Felated 3

Zheck Qut

Zuk Zhrl4x
Copy CErl+iC
Paste ([ B
Delete Del
Mark,

Set Icon...

Duplicake

Expand &l

Zheck Consistency

Business Model Diagran r
Physical Diagram

Rename

Properties. ..

Figure 26: Update Row Count

d. Ifan error occurs it means that the user name/password is incorrect or the ODBC connection
information supplied is incorrect.

10. Repeat steps 1-9 for each of the remaining Line of Business Subject Areas:
*  Commercial Property
*  Corporate
e Dwelling Fire
*  Homeowners
*  Personal Auto

¢ Personal Umbrella
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Step 3: Configure the Insight700Config Subject Area
1. Click on the Connection Pool icon under the Insight700Config Subject Area to open the

Connection Pool window.

Connection Pool - Connection Pool [_ O]
"wirite Back | Mizcellaneous I Aogregate Persistence
General I Connection Scripts I HHL
I ame; Connection Pool Pemizzions. .. |
Cal interface: [0 1001114 =l

M asimurn connectiong I 103: ™ Persist agoregates as Analptic Workspace

[ Bequire fully qualiied table names

D ata zource name; IINSIGHT?DDCONFIG
¥ Shared logon

Uzer name: IEIII_SYS

[ Enable connection pooling

Faszword: Ixxxxxxxxxx

Timeout; I
¥ Use multithreaded connections

[¥ Parameters suppaorted

[Infirite ]

|=olation level: I Default

Dezcription;

-~

=

x|

Cancel |

Figure 27: Insight700Config Connection Pool Window

2. Make sure the data source name is Insight700Config.

3. Make sure that the Require fully qualified table names option is unchecked.
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4. Under the “Shared Login” section, enter the same user name and password that you entered on

the Schema Configuration Parameters screen for the System Configuration Schema (see the
Oracle Insurance Insight Installation Guide).

o Oracle Universal Installer: Specify Insight S5chema Confliguralion Parameiers

Specily Insight Schema Configuration Parameters '™SVAANCE
Oracle Insurance Insight 7.0.0

_ENEIRIE §

Figure 28: System Configuration Schema User Name and Password on the Schema Configuration Parameters Screen

Note The default user name is OII_SYS. If you entered a different user name on the Schema

Configuration Parameters screen, use that name here.

5. Leave all of the other settings as is and click OK to close the screen.

Step 4: Check in the Changes to the Physical Layer

1. Check in all the changes by selecting the “Check-in” button at the top tool bar:.
2. Click the Save button.

3. Click the Close and Exit buttons to exit the OBIEE Administration Tool.
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Step 5: Restart the Services
1. Launch the Enterprise Manager by entering the following URL in your browser:
http://<hostname>:7001/em

Note In the above URL, <hostname> can be the server name or IP address where you
installed OBIEE.

ORACLE t

Enterprise Manager 11g
Fusion Middleware Control

H Complets & ity and Aodit M L 13
[l Configure Logging s Search Log Files

Figure 29: Enterprise Manager Login Screen

2. Log into Enterprise Manager using the administrator name and password that was specified
during the OBIEE installation. The Oracle Fusion Middleware Control will open.

ORACLE Enterprise Manager fuaion Wddiewars Coniral 115 Setmw HeDw Logut
item | dhTecdkgy
@- Farm_bifeundation_domalin & Logged n as weblogic
|7 i varm_ifoundation_domain Pagn Rafrashad By 1. 388 17150 P42 €07 3
Bl [ Apokcaton Deplkyymants
H [ Webloge Domasin =i Deplayments =i Fushn Middieware ﬁ
& OB ]
[T v emcphenn
# [ Metaclats Repedtores
. .:‘%' . -
e SmEd  Taget Hame Saaks ot o
E [ Apokca bon Deplaymenis
Ty p——— E [ sl o Dovvars 1
8§ sahveadil 11 O e & ol bfoundanon_doman
A By raiynclin 1.1 O bisereers B somrterce TR
i Ll 1 bisereed E b dater o
Bybadnrseraces(lL.. {F  Admederer & b server G poesgran
Yy baimin s 15, 1.7} 3 Admrsercer B [Zymumness inselgerce
B B, bocaisdmn( 1L L1} g bckete (5] cormacpieanen
Bybicaladmn(1l....  {F  bi_sererd £ [ Hrtactaly Raposforias
8 5 beddemare(1s.13) 3 bAsee [ meds o Phgsghald
T bescibemare 1 L. O bisereent

Figure 30: Oracle Fusion Middleware Control
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3. From the navigation tree on the left, select Farm_<domain_name>Business Intelligence>
coreapplication.

4. In the screen on the right, click on the Capacity Management tab and then the Availability tab.
5. Click on the Restart All button to restart the services. A dialog box will appear and ask you to

confirm your action to restart the services.

Ovierview Capacity Managemenlt Diagnostics Seurity Deployment
Metrics | Availability = Scalability  Performance

System Components Availability

@setal  [Jstopal | QRestartal [ Stert Selected [ StopSelected [ Restart Selected

Hame Statss  Host Port Orade Instance Mate:
= (5 BT Presentation Services

;_'ﬂ coreapplication_obips1
® [ 81 Servers

i)
o
& [ 81 Scheduers 4
a
&

=]

plgasight0l 9710 instance 1

(53 81 Cluster Controllers
® FE 81 JavaHosts
Figure 31: Select the “Restart All” Button

6. Click the Yes button in the dialog box to proceed with the restart. A message will appear to
confirm that all services have restarted.
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OBIEE REPOSITORY LINKAGE FOR NEW OR UPDATED LOB

Before you perform these steps it is assumed that the following tasks have been performed in the
Warehouse Palette:

* anew LOB has been created or an existing LOB has been modified,
e all Risk Entities for the LOB have been defined,

¢ all Attributes for the Risk Entities have been defined, and

* the LOB has been successfully published.

For instructions on how to do this please refer to the Oracle Insurance Insight Warehouse Palette
User Guide.

STEP 1: PERFORM AN IMPORT
1. Open the OBIEE Repository Administration Tool by selecting:
Start>All Programs>Oracle Business Intelligence>Administration

2. When the Administration Tool opens, select File>Open>Online to display the Online
Repository dialog box.

(98]

In the login dialog box that appears, enter the repository password (the default password is
welcomel) and click on OK.

4. Enter a valid user name and password. The default user name is weblogic and whatever password
you selected when you installed OBIEE.

The following Repository screen will open:

Eressntation [ ousiness Model and Mapping :
4 ([ Clhaen Morihly Srapthol BIF] creveesciad s % [ Commeici Auto
« ([l Claim Transaction +- @ Commercisl Piopesty B [ Commercisl Propey
+ [l Commercial Ao %l Comoste & [ Cowpoeste
+ IHI Commencial Propedty - t’ Drvrellireg Fue # [ DweelingFee
% ([l Coposste Dretad = B Homeovmery o [ Homeoweers
# ([l CreslingFan %l Personal Suto - [ IrssghtM0Contg
+ [l Momecwmens < Bl Peizonsl Umbrels = [ Pesons uko
=1 [l Porsonal duo 5 [ Pesonal Unkesla
* - [ Peisonal Umnboela
% [l Pobcy Transscton

Figure 32: Layers of the OBIEE Repository for Oll
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5. Select File>Import Metadata. The Import Metadata Wizard will open.

i import Metadata - Sebect Data Sowrce

n Select atas Source Tmport Type:
Connaction Type:
1 2 | Select Metadats Type:
| DsH | owiver |
3 Setect Metadsts Ohiscts [ coresppication_OHEIM301I0 Orade Bl Sarver 11g_OHEFI4301 10
L 1 g
4 Pellndy 1oy Loyt d el fnhen
5 &
Paspword: [
For Help, press Fl e

Figure 33: Import Metadata Wizard

6. From the Connection Type list select: OCI 10g/11g. The Data Source screen will change to the
one below:

Irnport Metadata - Select Data Source

n SEHI Dﬂldsw[l:ﬂ- WITM | o Maching d
Connction Tyrs T . -
2| Selsct Matsdsts Tepet
Dsta Source Mame: |
St Mal el
3| Swbeci Matadats Obpec TrT— |
A | Map to Logcsl Miode Password: |

= o | | oo

For Help, press F1 P

Figure 34: Data Source Screen with the “OCI 10g/11g” Connection Type Selected
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7. At the remaining fields on this screen you will need to enter the name and user/password of the

Insight700 database connection that you created for the OII installation as described in the
Oracle Insurance Insight Installation Guide.

e Data Source Name: Enter Insight700 as the data source name. This is the name of the
database connection that you created for the OII installation as described in the Oracle
Insurance Insight Installation Guide.

*  User Name/Password: Enter the same user name and password that you used when you
created the Insight700 database connection that you created for the OII installation as
described in the Oracle Insurance Insight Installation Guide.

Click Next. The Select Metadata Objects screen appears.

To complete the remaining import steps refer to the Oracle Fusion Middleware Metadata
Repository Builder’s Guide for Oracle Business Intelligence Enterprise Edition.

STEP 2: REGENERATE THE METADATA DICTIONARY

1.

]

: Address ||E} nisight_HomelInsurance)oiit 7. 0. Minstall\obieeimetadata_dic V| (ETu]

Go to the directory: <OIl_ROOT>\install\obiee\metadata_dic
For example:

C:\Oracle\Insight Home\Insurance\oii\7.0.0\install\obiee\metadata_dic

In order to preserve the original “out-of-the-box” metadata dictionary, create a new folder into
which you will place the regenerated metadata dictionary. In this example we will name this
folder: Insight 702 Custom.

metadata_dic

File Edit Miew Favoribes Toals Help ﬁ'

@Eack - \_;,l l.ﬁ pSearch “_ Falders v

File and Folder Tasks Insight_700

:j Make a new Folder

@ Publish this Folder o the
Web

e Share this Folder

Insight_700_Custom

Insight_701_Custom
Other Places

Details Insight_702_Cuskom

LJ ) ) )
1 1 1 I

0 bytes :ﬂ My Compuker

Figure 35: Create the Insight_702_Custom Folder
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3. From the Oracle BI Administration Tool menu select File>Open>Offline. The Open Dialog box

appears.
open  HH|
Lok ir: IE‘ repositony j - E‘F -

L= Insight_702 . rpd

L Tnsight_702_RI0001.rpd
L Tnsight_702_RI000Z . rpd
L= | Tnsight_702_BI0003.rpd

Dezkto Ju]

4

by Documents

File name: l j Open I
Filez of type: IHepnsitnr_l,l Files [*.rpd) j Cancel |

Figure 36: Select Insight_702.rpd
4. In the Open Dialog box select the Insight_702.rpd repository file and click Open.

5. An information dialog box will appear and states that the repository file can only be opened as
Read-Only.

6. Click Yes. You will be prompted for a password (the default password is welcomel).
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7. Enter “welcomel” as the password and click OK The Oracle BI Administration Tool screen will

open.
Physicll |
% ([l Claiem Mortbly Srapeheot . Um % [ Commercial Auso
# ([l Clam Tranaaction +- @ Commercisl Propesty + [ Commercid Property
+ [l Commercial Ao %l Comeoste [ Cotpoeste
+ .fﬁ.l Commercial Fropesty - kj Drvrellirsg Fue # [ DweelingFee
[}l Coupoeate retad + g Homeovanses o [ Homeowrer:
#- [l Dl Fun %l Peironal futo #- [ IntghtT0Conig
+ [l Momecwmens -l Peisonal Umbnels + [ Pesonal ute
- [ Peizonal futo 1 [ Pesonal Unbrela

# [l Peisonal Umbrela
[l Pobcy Transsction

Figure 37: Layers of the OBIEE Repository for Oll
8. Select Tools>Utilities. The Utilities dialog box will open.
Utilities =] E3
Replace Colurn or Table in Logical Table Sources Execute. I
Oracle Bl Event T ables
Externalize Strings |
Rename 'Wizard Cancel
Ipdate Physical Layer Hel |
Repositary D ocumentation :
enerate WMetadata Dictionary
Femove Unused Physical Objects

Aggregate Perzizgtence
Generate Deployment File

e

Figure 38: Select “Generate Metadata Dictionary”
9. Select Generate Metadata Dictionary and click the Execute button

The Choose Directory dialog box will open.

Choose Directory |

Select directory for metadata dictionary

Ok | Cancel |

Figure 39: Choose Directory Dialog Box

10. Use the Browse button to select the Insight 702 Custom directory that you created at the
beginning of this section.
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11. Using the manual, Oracle Fusion Middleware Metadata Repository Builder’s Guide for Oracle
Business Intelligence Enterprise Edition, define the proper logical layer and presentation layer
object for the newly added or modified LOBs.

STEP 3: DEPLOY THE METADATA DICTIONARY

1. Go to the directory where you created the Insight_702_Custom folder in Step 2: Regenerate the
Metadata Dictionary on page 73:

:<OII_ROOT=>\install\obiee\metadata_dic\Insight_702_Custom
For example:

C:\Oracle\Insight Home\Insurance\oii\7.0.0\install\obiee\metadata_dic\
Insight 702 Custom

2. Copy the entire Insight 702 Custom folder to:
<MW_HOME>\analyticsRes
For example:
C:\Oracle\Middleware\analyticsRes
The folder, Insight 702 Custom, now sits at the base of the analyticsRes folder. For example:
C:\Oracle\Middleware\analyticsRes\Insight 702 Custom

Important Once the copy is complete, go into the Insight_702_Custom folder and make sure you
have at least 36,000 files and over 1600 folders in total for this folder. If not extracted
properly, some files may become lost during the transfer due to the long path/file name.

3. :Rename the Insight 702 Custom folder to match the name of the repository file you initially
deployed as described in the Oracle Insurance Insight Installation Guide 7.0.2 (e.g.,
Insight_702_BI10003).

Overview = Capadty Management @ Diagnostics @ Security = Deployment

Presentation | Repository @ Scheduler Marketing Mail

BI Server Repository

This section sfows the current Instaleq RPD. You can use this section to configure a shared RPD |
Default RPDI Insight_702_BID0O3

Figure 40: Rename the Insight_702_Custom Folder to Match the Deployed Repository File

For example:
C:\Oracle\Middleware\analyticsRes\Insight 702 B10003
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4. Login back into Enterprise Manager.

5. From the navigation tree on the left, expand Farm_<domain_name>Business Intelligence>
coreapplication.

6. Select the Capacity Management tab in the screen on the right.
7. Select the Restart All button.

STEP 4: PERFORM OBIEE REPOSITORY LINKAGE STEPS

Return to the section, OBIEE Repository Linkage on page 62, and complete the steps in that section.
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Chapter 7

Balancing Reports

OVERVIEW

Balancing Reports are one method to verify data flow between schemas in the Oracle Insurance
Insight (OII) system. A typical OIl implementation contains three logical schemas: Stage,
Warehouse, and Data Mart. These schemas represent the stages of customer data as it is processed
in OII:

*  Stage — data in this schema is directly imported or fed by external systems. The data has not been
manipulated to fit into any particular data model other than what the external systems have
defined. This is the input to the following schema.

*  Warehouse — data in this schema has been processed through the first level of manipulation in
OII. Transactions will be categorized and parsed into the appropriate model tables, in preparation
for migration to the following schema.

e Data Mart — data in this schema has been aggregated into the appropriate model for the
customer’s lines of business. This is the end point in the process of the dataflow.

Since data is manipulated between the Stage-to-Warehouse and Warehouse-to-Data Mart flows, it is
important to validate that the transformation and migration logic for those flows is correct. The
Balancing Reports provide this capability in a convenient, easy-to-use format that provides reuse,
portability and flexibility.

COMPONENTS

OII is an Insurance-specific add-on to Oracle Business Intelligence Enterprise Edition (OBIEE).
OBIEE includes an additional component called Oracle Business Intelligence Publisher (BI
Publisher) that is used for generating reports, and as you might guess, the Balancing Reports are
authored using BI Publisher.

Additionally, the Balancing Reports rely on some additional data aggregation that occurs by way of
views built into the OII database structures. These views allow a consolidated picture of the data in
each schema that requires less complexity in the reports used in BI Publisher.
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DEPLOYING THE BALANCING REPORTS

Balancing Reports are a combination of templates, saved as RTF documents, and BI Publisher XDO
files, which contain the data mappings, parameters and all the other information that goes into the
generation of a report.

Follow the instructions in this section to setup and deploy the Balancing Reports.

PREREQUISITES

Prior to installing the Balancing Reports, make sure that the following prerequisites have been met:
*  BI Publisher is installed and running on your server.

*  The OII Reports catalog has been deployed along with the rest of the OII catalog files. All OII
catalogs should have been deployed when you configured OBIEE as part of the OII post-
installation process. Refer to the Oracle Insurance Insight Installation Guide for further
information.

» All Balancing Report related views have been created on OII_SYS (the system configuration
schema you specified when you installed OII) schema. Go to the OII_SY'S schema and verify that
the following views are present: CLAIMS DM, CLAIMS ST, CLAIMS_WH, EP_ST,EP_WH,
POLICY DM, POLICY_ ST, POLICY WH, XP_ST, XP_WH.

“# Oracle Universal Installer: Specify Insight Schema Configuration Parameters

OoORACLE
= - - INSURANCE
Specify Insight Schema Configuration Parameters
Oracle Insurance Insight 7.0.0

Slaging Schema : IOII_ST Password : |...........
Warehouse Schema : {o1_wH Password: [sssssse
Data Mart Schema : {on_om Password: (-
SEyEeAConsumtoNEcheiTiRY o1._5vs T ——
Work Schema : EOII_WRK Password : im
Warehouse Palette Schema:  [o1_wp Password: [~

Help | Installed Products... | Back Ned ) Install Cancel

Figure 41: OlI_SYS - System Configuration Schema
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STEP 1: CREATE A USER FOR Bl PUBLISHER

This step requires you to create a BI Publisher user with Administrator privileges.

1. Open the WebLogic Administration Console by entering the administrator user name and
password for the server domain that was specified during the OBIEE installation process.

ORACLE Weblogic Server® Administration Consala _
Change Center B Home Leg Ot Frefemences. (5] mecoed e D, | Weknme, webloghc | Comecied ta: bifundation_damain
View changes and restarts -
ik e Linck I ekt Bution tm modkfy, ack o Honue Page:
oSt (IEMS I el doman.
Lo b £t * Inbarsnalesn and Resburies
Helplul Tesh General Isdormates
& Corfoune ks o & Corrnon Aderir aten Task Desrptons
m Hecert Task S2atum m Fad S documentaton
Em = Sel your owecks preferences = gk & puestion on My Orade Suppart
3 imm';m w Criache Enterpring Mansger o Crche Gusrchan Crverviem
! eplcryrreriy
ey Domain Configuratons
i Eenarity Resms Imam SCTVETS Entrrcprrakdity
_ Ineraperablity w Domain » Memagng » T Servirs
- Dareges m e Servers & It Convecion Fooks
£ virosment # Stere-ared Formand Ageni
» Gervers = G Modbes [magnoalsy
. T e ® Palh Servces # Lo Fled
= Virtusl Hosts = frages » Duagrosic Modules
# My anshle Targen = XBC ¥ Dusrens: bnages
e o * Machres & [usis Sources = Reguest Performance
& Werk Mansgers = Fuin Data Souroes » Aechives
» Search the configurabon o Stariug v Suidow: Classes = [uts Source Faciones v Context
» e e Changs Certer ® Persstent Stoves * P
* Recond WLST Soip et Diephosped Resoiroes # 04, Regubied
* Changs Cormle prafirenons » Deployments % ML Enbity Caches Charts and Graphs
® Mot servers w Feregr PO Praviders » Montarng Dadhbosd

Figure 42: WebLogic Server Administration Console
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2. Select Security Realms in the left pane. The Summary of Security Realms page will appear on
the right.

{8 Home Log Out Preferences [&] fecord Help | Q, wﬂmmmﬂutfmﬁmdw bifoundation_domain
Hore »Summary of Seourity Realms

Summary of Security Realms.

A seourity nealm is a container for the medhanisms-nduding users, groups, seaurity roles, security polices, and security providers--that are

used ko protect Weblogic resources. You can have multiple searity realms in a Weblogic Server domain, but only one can be set as the
default (active) reaim,

This Security Riealms page ksts eadh seaurity realm that has been configured in this Weblogc Server domain, Chdt the name of e realm to
explore and configure that realm,

[ Customize this table

Realms (Filtered - More Columns Exist)
Click the Lock & Fditbutton in the Change Center to activate all the buttons on this page.

Showing 1to 1of 1 Previous | Mext

Hame & Default Realm

myreakm rue

Showing 1to 10f 1 Previous | Mext

Figure 43: Summary of Security Realms Page

3. Click on myrealm. The Settings for myrealm page will open.
Settings for myrealm
 Configuration  Users and Groups  Roles and Polices | Credentisl Magpings | Providers | Migration

General RDBMS Sequrity Store | User Lodeout | Performance

Click the Look & Fdif button in the Change Center to modify the settings on this page.

Use thes page to configure the general behavior of this security realm.

Bote:
IF you are implamenting security using MMCC [Java Authorization Contract for Containers as defined in J5R 115), you must use the DD
Only sequrity model, Other Weblogic Server models ane not avalable and the security functions for Web spplications and EX8s in the
Administration Console are disabled.

Name: myrealm The name of this security realm. More Info...

7] security Model e Specifies the default security model for Web ppications

Default: LA L or EJBs that are secured by this secunty realm. Youw can

override this default during deployment,  More Info...
5] Combined Role Mapping Enabled Detesmines how the role mappings in the Enterprise

Apphcation, Web application, and EJB contaners
interact. This setfing is valid only for Web applications:
and EM8s that use the Advanced searity model and that
irstialize roles from deployment desariptors.  More

Figure 44: Settings for myrealm Page
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4. Click on the Users and Groups tab at the top of the page, and then click on the Users tab to
display a list of configured users in myrealm.

Users
| New | showing 110 100f 10 Previous | Mext
1 | mame & Description Provider
[ | adminkstener APEX Listener admiristrator user Defaultauthenticator
[ |Bisystemitser BI System Liser Defaultiuthenticator
[J | manageristenar APEY, Listensar manager user DefaultAuthenticator
[ | cradesystemliser Orade sppbcation software system user, Defaulttusthenticator

Figure 45: List of Users

5. Click on the New button at the top of this table. The Create a New User Page opens.

Creabte a New User
0K | Cancel

User Properties

The following properties will be used to identify your new Uiser,

* Indicates required fields

What would you e to name your new Uiser?

" Names:

How would you ke 1o describe the new User?

Description:

Flaase choose a provider for the user,

Provider:

DefaultAuthenticator

The password 5 assodated with the login name for the new User.

* Password:
* Confirm Password:

0K | | Cancei

Figure 46: Create a New User Page

6. Enter the following information on this page:

* Name - Enter a name for the user. For example, bipadmin.

* (Optional) Description - Enter a description

*  Provider - Accept the default provider: DefaultAuthenticator.
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* Password - Enter a password that is at least 8 characters long.
*  Confirm Password - Re-enter the password.

7. Click OK. You will be returned to the Users tab where the user you just created will appear in
the list of users.

8. Ifyou are not already there, return to the Users page to display the table listing the configured
users.

9. Click on the name of the user you just created, bipadmin. A settings page for the selected user
will open.

Settings for bipadmin
General Passwords | Attributes  Groups
Save
LUse this page to change the description for the selected user,
Hame: bipiadin The login name of this user.  More Info...

Description: A short desaiption of this user. For example, the user’s
full name. More Info...

Figure 47: Settings Page for the Selected User
10. Select the Groups tab. The Groups page opens:

Settings for bipadmin
General Passwords  Attibutes  Groups

Save
Lise this page to configure group membership for this user,

Parent Groups: This user can be a member of any of these parent
Available: Chosen: groups.  More Info...

[ AdminChannelUsers L [ sladministrators

[] Administrators :

[] AppTesters ®

[] BlAuthors | €

[ sIConsumers @

[l CrossDomainConnector ™ |

Save

Figure 48: Groups Page
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11. Add the bipadmin user to the BIAdministrators group by selecting BIAdministrators in the
Available list box and using the arrow button to move it to the Chosen list on the right.

12. Click the Save button.
13. Exit the WebLogic Administration Console.

STEP 2: CREATE A JDBC DATA SOURCE

Now that you have created a user you must next create a JDBC data source within BI Publisher.

1. Open a browser and navigate to your BI Publisher installation. The URL for the installation
should be of the form:

http://<hostname>:<port>/xmlpserver/
Where:

¢ hostname - The hostname is the IP address or machine name of the server where Bl
Publisher is installed.

* port - The port setting will vary depending on the installation method used for BI Publisher.
If you installed a standalone BI Publisher setup, the port is usually 9704. Verify with the
console window where BI Publisher is running. If you installed BI Publisher under
WebLogic, the port is usually 7001. Again, verify with the console window where WebLogic
is running.

2. You will be presented with a login screen.

ORACLE BI Publisher Enterprise

Please enter usernams and password

LiSasmanms

Password

Accessiblity Mode [7]

Sign In

Figure 49: Bl Publisher Login Screen
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3. Login as the user that you created in the previous section (e.g., bipadmin). The BI Publisher
home page will appear.

| ORACLE  BI Publisher Enterprise

Create ..

;I Zppar®
% Separt b

% Data Model

Phgsre =

Hecent

A5

Browse Manage ...
ol Cansieey Foddes
B mepor obs
[P mrepsort sob Hissary

Get Started ...

g Domwriapd B Publisher Tools ™
@ e Corter s

. Orache Todwroogy b twork

Figure 50: Bl Publisher Home Page

4. Click on the Administration link on the top right corner. The screen below opens:

" adrmnisteavon QY T
£ Data Sources e System Maintenance
¥ |
4 g & IDBC Connection @ CErver I:mﬁguaﬁon
# JNDI Connection # Scheduler Configuration
# Fila # Schedular Diagnoscs
@ LDAP Connection
& QLAP Conmection
; Security Center 17— Runtime Configuration
WO s geaurity Configuration ! @ Properties
@ Roles ard PErmissions & Font Mappings
# Digital Sagriature # Cumrency Formats
3., Delivery 354 Integration
e | -
= # Dedhvery Configuration pu = Orade Bl Pressntation Senices
& Printer
@ Fax
& Emad
& WebDAY
#HTTP
*ETP
® CUPS Server

Figure 51: Bl Publisher Administrative Screen
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5. Click on JDBC Connection under the Data Sources section. The following screen opens.

DACLE' BI Publisher Enterprise Search I ¢

Adrki . Home | Catalog | J§ N
Administration > JDBC

Data Sources
JDBC JINDI File LDAP OLAP

Add Data Source |
Data Source Name Connection String Delete
demo jdbc:oracle:thin:@HOST:PORT:SID m

Figure 52: JDBC Data Source Screen

6. Click on Add Data Source. The following screen opens.

Apsply Cancal
Gereerral
" TDP Piaa mabs mors i raEsl B raguiesd ID0C driver cetse
TP otk Drpcin Fuoiates Minolprnrs Souety Mok, it ot List Syatee Lites chach bom 12wk B B Syaters Liar dar yons B Sarvnr Duatibais Comemcton
* Dt Soroe Hasw
* Criver Typs | Orache 119 -
" Dwisbaus Drivwr Ol || 373k b, OepdiaDotvad

* Conn b T
Fornaction Bring |y gheneachecthie G {host ] [pore]:fa]

Lia Sy Liar
s
Feamvord

Pk ot Fondmaon

Pt Prosinin Funoton

|.. 1t Proey Authentaton
Teat Coansction

Figure 53: Add Data Source Screen
7. Enter the following values:
* Data Source Name - [nsight7
* Username - O/l SYS
8. Fill in the appropriate connection information as it applies to your system.
9. Click on the Test Connection button to confirm that the connection is successful.

10. Click on the Apply button to save the settings.
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11. Click on the Catalog link in the menu at the top of the screen. The following screen opens.

My Folders -.r_

Subject Arca Contents | Last Modified 6/8/11 11:449 PM | Created By System Account

a0 Expand | More
= _temp | Last Modified 7/14/11 3:47 PM | Created By webiagic
=5} shared Folders z | Mors

B[ Commercal Auto
B[] Commercal Property
B[] Corporate

E(f] Oweling Fre
B3 Homeowners
E[] Personal Auto

E (] Personal Umbrella
E[3 Reports

Figure 54: Catalog Screen

12. Under the Folders tree, select Shared Folders>Reports>Balancing Reports. The Balancing
Reports will appear in the pane on the right once the data is loaded.

Catalog
: [Shared Folders Reports Balancng Reports V-
Claims | Last Moddfed 6/10//11 4:00 PM | Created By bipademin
Claims

Open | Schedule | Jobs | JobMstory | Edit | More™
Policy | Last Modified 6/8/11 11:45 PM | Creabed By bipadenin

E subject Ares Contents
e
EJ Drafts
EIES shared Foldars
B Commaraal Auto
EI§ Commercal Property
B3 Coporate
EE Oweling Fire
B Homeowners
B Personal suto
B Personal umbrela
B Reports
H[J Subject Area Contents
HfY Claims
HY Exscutive

Policy
Open | Schedule | Jobs | Job Hstory | Edit | Mone™

Premium A | Last Modified 6710711 7:37 PM | Created By bipadsin
Premium A
Open | Schedule | Jobs | Job Hstory | Edt | More™

Premium and Exposure | Last Modified 6/8/11 11:46 PM | Created By bipadmsin
Premium and Exposure
Open | Schedule | Jobs | Job History | Edit | Morev

Premium B | Last Modifiad 6/10/11 7:42 PM | Created By bipadmin
Premium 8
Open | Schedle | Jobs | Job Hstory | Edit | Mone>

Claims | Last Modified 6/10//11 4:08 PM | Created By bipadmin
undefined
Edit | More~

Policy | Last Modfied &/20/11 4:08 PM | Created By bipadmin
urdlefined

Edit | More~
Premium A | Last Modified 6710711 7:27 PM | Created By bipadmin
urdefined

Edit | More~

Premium and Exposure | Last Modified 6/10/11 4207 PM | Created By bipadmin
undefinad

Edit | Morev

Premium B | Last Modified 6/10/11 7:23 M | Created By bipadmin

urdefined

Edf | Morew

G 5§D

Figure 55: Balancing Reports
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BALANCING REPORT DESCRIPTIONS

OII provides the following five Balancing Reports,

CLAIMS

For each Line of Business, Claim Year, and Schema (e.g. Staging, Warehouse, and Data Mart), the
number of Claim transactions are given as well as the sum of the corresponding Claim Transaction
Amounts. Filters may be applied on the Claim Transaction Code, Transaction Year, and Line of
Business.

PoLicy

For each Line of Business, Transaction Year, and Schema (e.g. Staging, Warehouse, and Data Mart),
the number of Policy transactions are given as well as the sum of the corresponding Policy
Transaction Amounts. Filters may be applied on the Policy Transaction Code, Transaction Year, and
Line of Business.

PREMIUM A

The Premium A report provides the total Written, Earned, and Unearned Premium amounts among
the Staging, Warehouse, and Data Mart layers. Filters may be applied on the Year and Month.

PREMIUM B

The Premium B report provides the total Written, Earned, and Unearned Premium amounts between
the Policy Transactions table of the Warehouse and the Policy Transaction and Policy Monthly
Snapshot fact tables of the Data Mart. Filters may be applied on the Year and Month.

PREMIUM AND EXPOSURE

The Premium and Exposure report provides the total Earned and Unearned Premium amounts as well
as the total Earned and Unearned Exposure amounts among the Staging and Warehouse layers by
Line of Business, Year, and Month. Filters may be applied on the Line of Business, Year, and Month.

89



Chapter 7 — Balancing Reports

REPORT COMPONENTS

The following sections will familiarize you with some of the more common aspects of reports within
BI Publisher. For a detailed description of the BI Publisher report capabilities, refer to the following
manuals:

*  Oracle Fusion Middleware User’s Guide for Oracle Business Intelligence Publisher
*  Oracle Fusion Middleware Report Designer’s Guide for Oracle Business Intelligence Publisher
*  Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher

The complete BI Publisher documentation set can be found at the following link:

http://www.oracle.com/technetwork/middleware/bi-publisher/documentation/index.html

A report is made from the following components:

» Data Model — the source(s) of data used as input to the report. Various data model types are
available, but the Balancing Reports use only SQL statements to query the views and tables in
the OII model.

* List of Values — a List of Values (LoV) can be used as a source for a parameter list. LoVs can
come from a SQL query or a fixed list. The Balancing Reports use both.

* Parameters — user-selectable values that control the data displayed in the report.

* Layouts — Templates built around RTF documents which integrate data from the Data Model
using Parameters as filtering criteria. A report can have many layouts from which the user can
choose.

To view the components:

Each Balancing Report in the right pane has a corresponding Data Model. The components for a
Balancing Report can be viewed by selecting the Data Model for a report.

1. Login to BI Publisher and navigate to Shared Folders>Reports>Balancing Reports.
2. Click the “Open” link for a Balancing Reports Data Model (e.g., ‘Claims’).
‘ Claims | Last Modified 6/10/11 4:06 PM | Created By bipadmin

undefined
Edit | Morew

Figure 56: Click on Edit Link to Display the Report’s Components

You will see a display of all the components in the report.
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Report Components

The left pane displays a tree view of the report components. Clicking a component will display the

properties there of in the right pane and can also enable/disable the New, Delete and Ordering Arrows
displayed under the Report tab. In most cases you should not need to modify any of the components
unless you need to create a new report or layout.

Diata Hodel
Properties
Data Lioadel
& s
Evera T - . = | Il | BeEE -]
——— le B g it Packancs
ot o f Ve Feton S
L [
S B [T Ensble Scalsble Mode
L]
; sciiip Dt S [~ Ensble Badag Cornecton
e
B e TRANCO0E -
._“ " Switei o Bacu Dats Sowrce when Prmary
=l HERLA, Dats Sourie o urualabie
- T e Bacup Dats Source oniy
= d 04, Cupt Optons. [~ inciode Farameter Tags
¥ Indide Empty Tags for Mull Blements
B eraarvmas  Indlude Group st Tag
B M. Tag Display | Upper Case -
=)
Attachment
sy Dt A e
——.

Figure 57: Report Components
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DATA MODEL

Most reports feature a single data model, which contains a detail SQL query to pull the data for the
report. Do not modify the data model unless you have reason to do so. You can also specify the data
source (defined in the installation steps) for the Data Model.

The output from the data model is XML data that is used as input to the report engine.

LIST OF VALUES

As mentioned previously, Lists of Values (LoVs) are used as sources for parameters applied to
reports. The Balancing Reports each define similar sets of LoVs depending on the data model and
required output in the report. An example is shown below:

List al Vakies
18 Ueete
. + X
“Hame Ty Clats Sourge S gy
i Ciama W= 5L Query e | traght? w (=10}
il il e SQL Query »  reght? » =
mateiy o TR SO8 Query 3 || inmght? > |l
I'_. e lovSOHENA Frord Dats w |
o YEAR
B oo
i
K w
= Pl -
&  IVYEAR: Type: SQL Query
= wions [ Cache Renit
= L Guery
g =T
& Qe
G SELECT DESTINGT CLATMYEAR FROM [ SELECT DESTINGT CLADMIEAR PROM CLADMS 5T LNION ALL SELECT DISTINCT CLAIMYEAR FROM CLADMS_WH LIICH
AL SELECT DASTINCT CLAHYEAR FROM CLAIMS DM ) DRDER BY |

Figure 58: List of Values

The source for the “lovYEAR” is an SQL statement. A LoV may also contain a list of hard-coded
values.
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PARAMETERS
Parameters are used as filtering criteria for a report, and are referenced in the SQL queries in the
report’s Data Model. Parameters have several different types, however the Balancing Reports only
use the “Menu” type, which means that the parameters are displayed as Drop-down selectors with
data from LoVs. The parameters are defined to allow the user to select multiple or all values, as

shown below:

4 PSCHEMA: Type: Menu

Lehema
= | e SHEMA w
iz e [ Muitpie Seiecton
W' Can select al

' MULL Vale Passed 1= A vakaes Passed

[T Fosfresh ofher parmmeiens on change

Figure 59: Parameters

TEMPLATES

A Template is a document which defines the fields, grouping, aggregation and display of data in a
report. BI Publisher has many available template types; however Balancing Reports are all created as
RTF templates. You may use Template Builder for Word-in to author templates.

LAYOUTS

A Layout is a correlation between a template and a set of allowed output types. The Balancing
Reports allow all output types. You can view available templates by clicking on the Edit link for a

Balancing Report.

wmz| Claims |Last Modified 8/3/11 8:53 PM | Created By bipadmin

E Claims
Open | Schedule | Jobs | Job History | Edit | Morew

Figure 60: Select the Edit Link to View Templates
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A list of available Layout templates will appear.

tome | Catleg B tew~ BB Open~ | Sgnedin ds weblogic

CotaModel (loms & " Parameters g Preperies [ View Report H_Eﬁ_ kﬁ_
Wirw Thumbnads | vesoalst
o s reew Lot

E

|

fummary Ertad: LOH-Sarty Claim Code-Toar Dot LOB-Yipar lam Code-Party Ertad: LOB-Sarty Toar-Clam Code Drtad: LOB-Viear Sarty-Clam od
Edit | Properes | Delene Edt | Propermes | Delete Edit | Properes | Delene Edt | Propermes | Delete Edit | Properes | Delene

Figure 61: List of Layouts

You can download a layout by clicking on the Edit link and saving it to your machine.

File Download rz|
Do you want to open or save this file?

@ j Mame: Claims Balancing Surmmary Sheet, rtf
Type: Rich Text Format, 53.3KE

From: 10.143.9.77

Open ] [ Save ] [ Cancel

harm your computer. |f vou do nat trast the source, do ot open or

|@ While files from the Intermet can be uzeful, zome files can potentially
L
= zave this file. What's the risk?

Figure 62: Download a Template

If you need to make changes to a template, simply download the RTF template, make edits, and then
upload again, at this screen, using the same file name. You will be prompted to overwrite the existing
template. You can also download sample data that is provided with the reports. You can use this
sample data with the BI Publisher Add-in so reports can be modeled off-line from the BI Publisher
server and data sources.
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VIEWING REPORTS

To view a report:
1. Under the Folders tree, select Shared Folders>Reports>Balancing Reports
2. Click on the report name (e.g. “Claims”) to view the report.

The reports are configured with various drop-down selectors that allow customization of the
parameters to the report. These selectors enable reporting on different slices of data that correspond
to key data points in a typical business application and lifecycle:

*  The default layout for the Report is displayed automatically when the report is initially displayed.

*  You can change the input parameters to the report and click the Refresh button to update the
display.

e Ifyou want to include multiple selections, hold down the CTRL key while you click your
selections in the dropdown.

* You can select “All” at the top of the dropdown lists, to include all values for that selector.

Dt

Page 1of 1Ciaims Trantaction Balancing 8/10/2011 14:45:13 PM
Figure 63: Viewing a Report

The tabs across the top of the screen allow you to change the Template to display data in according
to the different templates that are assigned to that report. The Balancing Reports typically offer a
Summary and Detail template, which presents two ways to view balancing data.

Summary ' Dotal LOB-Party-Chim . | Detslz LOS-Year-Claim . | Detmil: LOB-Party-Yoar-. | Detsd: LOS-Year-Party-.. . W g=®
Page 1 of 1Claims Transaction Balancing 8/10/2011 15:11:41 PM

Figure 64: Balancing Detail

Some of the Reports offer multiple Templates to change the aggregation points of the data, which
presents the report in a slightly different format depending on your requirements and balancing
techniques.
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You can also change the output format using the appropriate dropdown. By default, the output is
displayed as an HTML version of the template. If you want to save a report, you can click the View
Report button to download it to your local machine.

fy-e ”@Jv E,|®

HTML

EEE

¥ @]

PDF

RTF
Excel

PowerPoint 2007

@ [® =

Figure 65: Selecting a New Output Format

MODIFYING REPORTS

Modifying the reports may become necessary over time if OII data models change, or as reporting
requirements evolve. Since reports are built from several different components, modifying a report
depends on what you need to accomplish. Data for reports is provided by way of SQL Views built
into the database. The views are queried by Data Models in Bl Publisher, using Parameters, which
are sourced from Lists of Values as filters. Therefore, you must determine at what level the change(s)
must be made. The simplest changes are to the templates themselves.

CHANGING A TEMPLATE

In order to modify templates, you must have the Template Builder for Word installed. You can
download the Template Builder for Word while in BI Publisher from the link under the Get Started
section on the BI Publisher Home Page.

Get Started ...

% Download BI Publisher Tools *

Template Builder for Word
Analyzer for Excel

Crade S0L Developer

Figure 66: Selecting Template Builder

e Use the Template Builder for Word to access BI Publisher server — this option allows you to
interact with the BI Publisher server online using live data.
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*  Download templates from BI Publisher manually — this option allows you to download templates
and data for offline modification. You will need to upload the template back to BI Publisher once
you have completed your changes.

Online Template Modification
1. Start Microsoft Word, and open a new blank document.
2. On the Add-Ins tab, select Oracle BI Publisher->Log On.

3. Enter your credentials and ensure the URL to the report server is correct, then click the Login
button.

4. Once you have logged on, navigate to the appropriate folder containing your report.

5. Click the folder on the left tree, and the available reports for the folder will be displayed in the

top right pane.
B Open Template HEH
Workspace: Bl Publisher * "y Up Viewas =
= D?HWFM Elaparts
+ [ Balancing Repost:
. If‘_* Boderriger L Hsrne | Tt | Deserption | Tape | Mecttod
5 (07 Eusiness Intsligence = Ciyms Clama Bl Publsher Feport 1029/20101
+ () Ewscutive i Pobeoy Pubey Bl Publshar Repest 1072920101
# [ Franciala 4= Preeium A Fremium A B Publisher Repord 102920 2
+ (1 HR Manager = Prmmim B Fremum B B Publisher Faport 2920001
= Ireght ' Presmim and Ex.. Premium and Expos B Pubdsher Peport 1022000 1
< ] 0d
SEmmE. -
# [ Marloeting
L O Selea M Layout Templates
¥ (77 Supply Chain Maragement Tane | Fierume [ Type [ Locain | Ougpns Formats
* I:' Training
# ] My Foldens
| Canca

Figure 67: Available Reports

6. Once you click an available report, the layout templates for that report will be displayed in the
lower right pane. From here, you can create a new layout template, or edit one of the existing
templates.
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To Edit an Existing Template:

1. Click the template and then click “Open Layout Template™.

B Open Template

| Locale | Ontpt Fornats |

HTML. PDF, RT..
HTML. FDF. RT..
HTML. PDF. RT..
HTML. PDF. RT,
HTML. FDF. RT..

Open Report |  Open Layout Template | Cancel |
e

Figure 68: Select “Open Layout Template”

2. When you have completed your editing session, you can upload your changes directly into the
existing layout template, or you can create a new template.

To Update the Existing Template:

* Go to the Add-Ins tab and select Oracle BI Publisher = Upload Template.

{Eﬁ-'ll H L N template3.rf - Report: Pohcy Trandachon Premiom Template: Pe

ol
Haome Insert Page Layout References Mhingt Fenew Verw dudd-ng

Ovache H Publisher=| Duta - Indedt = Preview = Tooli = Help -

M~
Log QN
| % Open.. Custom Tooibars
a “"“““""“‘g TR A E TR E A
k Uglad Templabas.,
l| Insert 3

Figure 69: Select Upload Template
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To Create a New Template:

*  Go to the Add-Ins tab and select Oracle BI Publisher-> Upload Template As... and then enter the
new template name when prompted. You’ll see a confirmation dialog following successful

upload.

Jiboload o e E Microsoft Word E

The template New Policy Calc was added to the report Policy Transaction Premium

' Template Name | New Policy Calc

ot | ono | =)

Figure 70: Create a New Template

Offline Template Modification
1. Login to BI Publisher and navigate to Shared Folders>Reports>Balancing Reports.

2. Locate the Balancing Report whose template you plan to edit and select the Edit link.

wmz| Claims |Last Modified 8/3/11 8:53 PM | Created By bipadmin

E Claims
Open | Schedule | Jobs | Job History | Edit | Morew

Figure 71: Select the Edit Link to View Templates
A screen of available Layout templates for that Balancing Report will appear.

B ‘e Gtieg| Biew- | Booen - Sowdinks weblogc |
Craaretes  (drepenes  (Evenmeen |H @

Dot Moced g '::L 3
View Thumbnads | Vew sl

o ackd e vt

il | OB-Par by-Teur Lipm Code ot LOB-Tear furty-Clam Cod

ey Doiad LOB-Party Llaim Code-Tear Dorind: LOB-Yar Ll Coce-Party
Edn | Properies | Debehe Eda | Propertes | Dalehe

Edn | Properies | Debehe Eda | Propertes | Dalehe

Eda | Propertes | Dadele

Figure 72: List of Layouts
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3. Locate the template you wish to download and click on the Edit link to save it to your machine.

File Download |

Do you want to open or save this file?

@ j Mame: Claims Balancing Surmmary Sheet, rtf
Type: Rich Text Format, 53.3KE

From: 10.143.9.77

Open ] [ Save ] [ Cancel

harm your computer. |f vou do nat trast the source, do ot open or

i jl While files from the Intermet can be uzeful, zome files can potentially
L
= zave this file. What's the risk?

Figure 73: Download a Template
4. Click the template you wish to modify. The template will be downloaded to your local machine.
5. In the BI Publisher catalog, navigate to the report and click the Open link.

6. Click the Actions icon, then click Export, and then click Data. You will be prompted to save the
XML file for the template.

7. Save the file to a local directory on your machine.
8. Use the Load Sample XML feature below to load the saved XML file.
9. Open Microsoft Word and open the template you just downloaded.

10. You can now proceed to edit the template.

MODIFYING A TEMPLATE

Before any template modification can begin, data and schema for the template must be loaded. If you
are working online, this has been done for you automatically. If you are working offline, you will
need to perform the following instructions:

1. Onthe Add-Ins tab, click “Data—>Load XML Data...” and select the downloaded XML file. You
will see a dialog box indicating successful load of the data set.

Note The BI Publisher Add-In data load applies to all instances of Microsoft Word that you
may have open, so if you are editing multiple templates that do not use the same data
set you will have to load the appropriate data for the template before performing
operations with the Bl Publisher Add-In.
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Please select XML data

Look in: [ 3 Reponts =] « @ ek - '

=) wo_sample_d it [

ai Date 10 10 12:22 PM

(=] wdo_sample_dd e 6.69 MB

b
. Data loaded successfully
LT | File name [Poscyxmi = Open |
S v crert T e ]| [

Figure 74: Download Data

Note

You can still load data if you are working online, however any data load you perform will
override the live data provided by Bl Publisher. If you want to revert to the live data, you

will have to log off and log on to Bl Publisher. To do this, go to the Add-Ins tab and select
Oracle Bl Publisher -> Log Off, then Oracle Bl Publisher -> Log On.

2. Now you are ready to modify the template. The easiest method to insert a field is to use the Field
Chooser.
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3. Display the Field Chooser by selecting the Add-Ins tab, and then Insert->Field...

The Field Chooser will display the available fields in the loaded XML data set. You can apply
calculations such as SUM or AVG on a field by selecting the appropriate item from the

dropdown.
|
I_ p— Tor—
(I Find - Find Mext I
== <ROWSET>
= B
O <SOHEMAS
O <TRAMSYEAR >
O <08
O <PARTY>
O <POLICYTRANSCODE >
O <POLICYTRANSAMOUNT >
by Dby
Home Insert Page Layout Referen :
Calulation [ -] r
QOracle BI Publisher ~ Data ~ |Insert = | Preview ~ To
I™ Force LTR Direction
abl Field,.
[ Table'Wizard...
Please select a node in the ree,
Menn Commanids M oreaoaeo = - .

Figure 75: Field Chooser Dialog Box
4. To insert a field, highlight it and click Insert. The field will be inserted into the template.
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Using the Wizard to Generate Tables and Fields

You can also use a wizard to generate tables and fields for you based on the data in the XML file. To
run the Wizard:

1. Select Insert>Form Wizard... from the Add-Ins tab.

ot Page Layout References Mailings R

Data = |Insert =| Preview = Tools = Help -

ab| Field...

2] Table Wizard...

| e/Form % |
2l Pivot Table R

Figure 76: Start the Wizard
2. Select the Table format for your report.

Table Wizard | x|

Please select your report format
ke % [rable]|

" Form

1 Free Form

Figure 77: Select Table Format
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If your report contains multiple data sets (e.g. the report has more than one Data Model defined
in BI Publisher) you can select which set you would like to see in the report. BI Publisher also
offers the ability to combine multiple Data Models into a single data set, in which case you would
see only one choice, as shown below:

Tabl Wizard x|

Which grouping field do you want to report on?

Diata Sat =]

Table Wizard E

Figure 78: Select Data Set

Select the fields you want to appear in your report. The order of the fields below is not important
at this time.

Which ficlds do you want to show in your report?

PARTY SCHEMA

Figure 79: Select the Fields for the Report

104



Modifying Reports

4. For the purposes of balancing data, grouping is very important. Most of the reports have different
methods of grouping data depending on how the balancing information must be viewed. At this
screen you can configure the order of grouping.

Table Wizard n |

How would you like to group your report?
+ Group sbove [ Cata sready sorted
L ™ Group left Breski g Beeak |
Then By
Iﬁ i+ Group sbove [ Data slready sorted
™ Group left Breskt o Bresk |
Then By
l_._.—_l (" Group above [ Data slready sorted
SCHEMA x
™ Group left Bresc:  [jo Break =l
| ThenBy Q
+ Group shove ™ Dats sresdy sortesd
ut
[ i " Groupleft Bresk: [y Break =]

Figure 80: Configure Order of Grouping
5. To enable sorting of data, select the field, direction, and data type for sorting.

Table II'!'E{IFd E |
‘Which fields would you like to use to sort the data?
% fscending = Date/Text
i " Descending T Mumber
* 2 [
;I r [l
= ~
;I r Ll
= ~
I = |~ e

Figure 81: Enable Data Sorting
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6. You can set up labels for any fields that are not used in grouping or sorting. These can be changed
later.

How do you want to label the fiekls?
Field Label
POLICYTRANSCODE [m_rnmﬁcme =
POLICYTRANSAMOUNT [mmmtus»um
Ll
=] o | o | |

Figure 82: Setup Labels

Viewing the Output

After the wizard is completed, you will see the generated output. The items with gray highlight
indicate special fields placed in the template. You can rearrange the generated output, create tables
and modify fields just as you would a normal Word document.

Output Generated by Wizard:

—

LOB
Broup by TRANSYEAR

TRANSYEAR
group by SCHEMA

SCHEMA
POLUCYTRANSCODE | POLICYTRANSAMOUNT
F POLCYTRANSCODE POLICYTRAMSAMOLINT E

end by SCHEMA
end by TRANSYEAR
end ROW by LOH

Figure 83: Output Generated by Wizard
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Reorganized Output:

Page 1 of 1 Palicy Transaction Balancing 11/12/2010 2:04:51 PM

Balancing Summary Sheet|

aor Sumal Trandactions
Transactions

Transaction Year

Figure 84: Reorganized Output

To preview the report with data, click Preview on the Add-Ins tab, and select the appropriate output
type from the dropdown. The report will be generated using the loaded XML data.

AEnAA®

axit Beacker - [651 2859575937 Jout. paf]

b Pie £t . Forms Tock e [ sacanty your POFs with Fhantom MI-IES
IBE®B|s - |les|gElamq-GHe - -l % Ll
Wk E@r® A

Policy Transaction Balancing 11/12/2010 16:06:00 PM
o

Balancing Summary Sheet

Line: Dwelling Fire
Transaction Tear Schema _ Sum of Transactions

2008 STAGE 222,4852.5
2005 WH 3y 20 222, 456&, 00
2006 STALE 5,739 223, 920. 00
2006 WH T, Ta% 243, 920.00
2007 4,611 £27,233.00
WH a,B11 227,233.0
STAGE
“H

Figure 85: Preview a Report
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Customizing the Report

You can further customize the report by changing the grouping and calculations.

Changing Grouping

An example of a grouping is shown below. Access the grouping by double-clicking on a grouping
field, or by highlighting some text or fields in the document and selecting Insert->Repeating Group...
from the Add-Ins tab.

The first tab, Properties, shows the correlation between the data input and the grouping selection. The
For Each selection corresponds to a data row element in the XML, as shown here:

Bl Publisher Properties E 1 <?xml version="1.0" encoding="UTF-8"7>

Properties | Sorting | Advanced |

bk

3 [J<ROWSET>
4  H<ROW>
<SCHEMA>STAGE</SCHEMA>
For Each |Row k| € | <TRANSYEAR>2005</TRANSYEAR>
7 <LOE>Dwelling Fire</LOB>
I™ Absalute Path & | <PARTY>INSD</FARTY>
<POLICYTRANSCODESNB</POLICYTRANSCODE>
Group By fLoe =l 10 | <POLICYTRANSAMOUNT>3.5¢/POLICYTRANSAMOUNT>
b < /ROW>
H<RoW>
<SCHEMA>STAGE</SCHEMA>
<TRANSYEAR>2005</TRANSYEAR>
Word Proparties 0K | Cancel | 15 |<ros>Dwelling Pire</LoS>
<RPARTY>THSD: FPARTY >

Loop

Break: Mo Break -

b=k
1 B L B

n

Figure 86: Properties Tab

The Group By selection corresponds to the selection made in the Wizard, however this can be
changed using the dropdown. You can also change the Sorting properties as well:

Bl Publisher Properties |
Properties Soding |
Sort By
fuoe =] [hacondng =] [DateTe =]
I =l = x|
I = = =l
I =l =l =}

Vord Properties ok | camcel |

Figure 87: Sort Properties
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The Advanced tab shows the underlying field codes which will be inserted in the template, and allows
you to change the text that is displayed as a place holder in the field.

Bl Publisher Properties

Propedties | Soting  Advance
Code

< Hor-each-group: ROW . /LOB7>< sof .cument -group
(WLOE: ascendng’ data fype=texdt 7>

Texttodisplay  foroup ROW by LOB

\ord Properties

Cancel |

Figure 88: Advanced Tab

Once you have become accustomed to editing the field code directly, you may not need the various
tabs offered in the field properties and instead you may edit the properties in the Code box as shown

above.

Changing Calculations

Another common activity with Balancing Reports is to apply a calculation to a field. In most of the
reports, there is at least one field that includes a SUM or COUNT calculation. Double-click a field to

see its properties:

Bl Publisher Properties

Properties | Advanced |

General

Data Field [CLAMTRANSAMOUNT =]

Text to displey  [0.00

Fonmatting

Type { Mumiber =

Format |e.420.00 ;l
I™ Force LTR

Diata Aggregation

Function CEE

Scope Group lem

WWerd Properties

Figure 89: Applying a Calculation to a Field
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The field shown below has a Sum calculation that is scoped to all CLAIMTRANSAMOUNT fields
within the grouping. Additionally, the value is formatted as a number that has precision to two
decimal places, and optionally includes comma formatting if the value requires. You can change the
calculation using the Function dropdown if the field is already in place on the report, or you can set
the calculation when adding the field to the report.

Field BEE
Fd [ ] eodnen

<HCHEMA >
CCLADMYEAR >
<108>
<PARTY >

Cooooao

SOLATMTRAMSAMOUNT >

Figure 90: Select a New Function from Drop-Down List
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Be sure to check the On Grouping control when adding fields to a report, and verify that your
grouping is set up appropriately. Occasionally grouping can be confusing so it helps to view the
groups in the report itself:

4

group ROW by LOBLine:LOB

Claim Year Schema #Of Sum of Transactions
Transactions
group by CLAIMYEAR | group by t | 0.00end by SCHEMA end
CLAIMYEAR SCHEMASCHEMA by CLAIMYEARend ROW by
LOB
Propertes | advanced | Propesties | Advanced |
Ganeral Laefer
Diata Field CLAMTRANSCODE - Drats Fidd JOLAIMTRANSAMOUNT -
Tedwodspsy Textiodagley [000
e e G I a—
Formal & mal = Fomat o i) D0 |
[~ Forca LTR I ForcaLTR
e = T
Soope Ginoup Hem Scope Groug Hem
\ord Properties oK | Coacel Vord Properies | 0K Cancel 1.

Figure 91: Viewing Grouping in Report

In the report shown above:

The top-level grouping is by LOB. That means that the table will be reproduce for each distinct
LOB group.

The next levels of grouping are CLAIMYEAR and SCHEMA, and you can see that the field
values for each are output directly after the grouping field.

Next is a field which represents the number of transactions at the grouping of LOB,
CLAIMYEAR and SCHEMA. That number is shown as field ¢, and uses the COUNT function
scoped to the current group.

Finally, the Sum of transactions field is shown, represented by 0.00, which indicates that the field
has a Number formatting attribute set. This field has the SUM function scoped to the current
group. This report might be expressed in plain English as “display the count and sum of
transactions, grouped by LOB, CLAIMYEAR and SCHEMA.”
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An example of the output is shown below:

Balancing Summary Sheet
Line: AUTOCC

Clairm Year Schema
05 STAGE
2005 WH
006 STAGE
06 WH
007 STAGE
2007 WH
2008 STAGE
08 WH
Line: DFIRE

Claim Year schema
2005 STAGE
005 WH
2006 STAGE
W06 WH
0T STAGE
2007 WH

Figure 92: Sample Summary Report

rof
Transactions
1,272
1,272
1,832
p RS
727
727
238
238

rof
Transactions
Ta90
T30
1,379
1,378
T4E
T46

Sum of Transactions

1,104,530.24
1,104,530.24
1,%50,056.688
1,950, 058.88
820,009.71
820,009.71
46, 638.68
46, 65B.68

Sum of Transactions

1,264,502.62
1,264,502.62
5,476, 350,48
5,476, 350.48
859, 666.38
859, 666.38

112



Appendix A

Relationship Codes

PARTY-LEVEL RELATIONSHIP CODES

Oll_ST.PARTY (Party)

CA DRV
CLMT
CLM_ADJ
CLM_EXAMR
CLM_MGR
INSD

« INSUR CO
PAR_INSUR CO

« PA DRV
PRODR

« REINS_CO
SUB PRODR
SUPPLIER
Uw
UW_ASST

TYPE-LEVEL RELATIONSHIP CODES

OIl_ST.ORG (Organization)

« CLMT
CLM_ADJ
INSD
INSUR_CO




Appendix A — Relationship Codes

« PAR INSUR CO
« PRODR

« REINS CO

« SUB_PRODR
« SUPPLIER

OII_ST.PERS (Person)
« CA DRV

« CLMT

« CLM_ADJ]

* CLM_EXAMR
« CLM_MGR

*+ INSD

« PA DRV

* PRODR
 SUB PRODR
e SUPPLIER

« UW

« UW_ASST

ROLE-LEVEL RELATIONSHIP CODES

OII_ST.INSUR_CO (Insurance Company)
« INSUR CO

e PAR INSUR CO

OIl_ST.PRODR (Producer)

« PRODR

« SUB PRODR

OIl_ST.UW (Underwriter)

« UW

« UW ASST
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CONTACT CODES

OIl_ST.CNTCT (Contact)

OIl_ST. PSTL_ADDR (Postal Address)

CA_DRV
CLMT
CLM_ADJ
CLM_EXAMR
CLM_MGR
INSD
INSUR_CO
PAR_INSUR CO
PA DRV
PRODR
REINS_CO
SUB_PRODR
SUPPLIER
Uw
UW_ASST

CA_DRV
CA_VEH
CLM

CLMT
CLM_ADJ
CLM_EXAMR
CLM_MGR
CP_BLDG
DF_DWLNG
HO DWLNG
INSD
INSUR_CO
PAR_INSUR_CO
PA DRV
PA_VEH
PRODR
REINS CO
SUB_PRODR
SUPPLIER
Uw
UW_ASST
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Scope, 13

F
Fact Tables

Data Mart, 29
Facts, 28
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G
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K
Keys

Common/Shared, 43
L

Line of Business, 3
Commercial Auto, 3
Commercial Property, 3
Dwelling Fire, 3
Homeowners, 3
Personal Auto, 3
Personal Umbrella, 3

Load Options, 48, 51, 55

Loading to Staging, 24

Loss, 46

M
Master Data Management Strategy, 33
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N
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Deployment, 11

Execution, 11
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Salvage, 46
schema
normalized star schema, 28
snowflake pattern, 28
Slowly-Changing Dimensions, 5
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Source-to-Staging ETL, 33
Staging Model Concepts, 17
Contact, 18
Party Model, 18
Postal Address, 19
Relationship Model, 21
Staging to Warehouse, 26
star schema, 28
Subrogation, 46
System Codes
Claim Transaction Code, 46

T
Transactional Marts
Combined Policy & Claim, 4

U

Unallocated Adjustment Expense (ULAE), 46

Unique Keys, 43

\%
Views, 30
Corporate Views, 30

W
Warehouse to Data Mart, 28
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